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Dobot Magician User Manual Instruction and 

PrecautionsDobot Magicianユーザーマニュアルの説明およ

び注意事項 

1. Please refer to the Dobot Magician User Manual along with the box before using.  

ご使用前に、必ず商品に同梱されているユーザーマニュアルをお読みください。 

2. Precautions: 

注意事項 

1) Power On: Please align the Dobot into the “neutral position” by making a 45° angle between 

the forearm and rear arm (shown below), press the power button, and the stepper motors will 

lock. After about 5 seconds, there will be a short sound. If the status light switches from 

orgnge to green, the Dobot is ready to use. Note that if the light turns red, it indicates that the 

Dobot is at a limited position, so please make sure the forearm and rear arm are kept in the 

normal range of motion.  

電源を ON にする：フォアアームとリアアームの間に 45°の角度をつけて（下記参

照）、Dobot を「中立位置」に合わせてください。電源ボタンを押すと stepper モー

タがロックされます。約 5秒後、短音が鳴ります。ステータスランプがオレンジ色か

ら緑色に変わると、Dobotが使用可能な状態になります。ランプが赤色点灯する場合、

Dobotが制限された位置にあることを示しています。この場合、フォアアームとリア

アームが正常な動作範囲にいるように調整してください。 

 

2) Power Off: If the status light at the bottom right of the Dobot is green, press on the power 

button to turn off Dobot. In this process, Dobot will move slowly to the “resting” position. Be 

safe and watch your hands! 

電源を OFF にする：Dobot の右下にあるステータスランプが緑色点灯する場合、電

源ボタンを押すと Dobot を OFF にすることができます。その後、Dobot はゆっくり

と「休止」の位置に移動しますので、手などの安全に十分ご注意ください！ 

3) If the Dobot becomes unaligned with the computer, press the Reset button behind the 

controller to recalibrate. The Dobot will automatically disconnect with the computer and reset. 

Then you can reconnect it. 

Dobotがコンピュータの指示により位置合わせされなくなった場合、コントローラー

の後ろにある「Reset」を押して再調整を行ってください。Dobot は自動的にコンピ
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ュータとの接続を解除し、リセットします。 その後、コンピュータに再接続するこ

とができます。 

4) Please turn off the Dobot completely first before plugging or unplugging external modules, 

such as Bluetooth, WIFI, Stick controller, Infrared sensor, Color sensor etc...Not powering 

down the Dobot before doing so may damage or break your Dobot! Note that only once the 

status light completely turns off, the Dobot has powered down. 

Bluetooth、WIFI、スティックコントローラ、赤外線センサとカラーセンサなどの外

部モジュールを接続または取り外す前、必ず Dobot を完全に OFF にしてください。

電源を切らない場合は、Dobotが損傷または破損することがあるのでご注意を！また、

ステータスランプが完全に消灯された場合のみ、電源が完全に切れることを意味しま

す。 

5) When packing and transporting the Dobot, please unplug the left and right motors wires 

located near the sides to avoid damage to your Dobot. 

Dobotを梱包して搬送する際は、損傷を避けるために、左右にあるモーターワイヤー

を取り外してください。 

3. Important Safety Notice： 

➢ Small spare parts are included, so please keep them away from children, as they are a 

choking hazard. 

➢ DO NOT let children play with the Dobot alone. All processes need to be monitored 

while running. After processes have finished, please turn off the equipment promptly. 

➢ While using the laser module, please wear protective glasses. Avoid eye or skin exposure 

to direct radiation. Keep a safe distance from the laser to avoid accidental injury. 

➢ When using the 3D printing module, the heating rod will produce temperatures up to 

250℃, please be careful! 

➢ DO NOT put hands into the operating zone while the Dobot is running. Not doing so 

runs the risk of bruising and/or pinching. 

重要な安全上のご注意： 

➢ 小さなスペアパーツが同梱されておますので、窒息の危険を避けるために、子供

の手の届かない場所に保管してください。 

➢ 子供一人で Dobotで遊ばせないでください。実行中に全プロセスを監視する必要

があります。プロセスが終わると、即時に装置の電源を切ってください。 

➢ レーザーモジュールを使用する間に保護メガネを着用してください。目や皮膚に

放射線が直接あたらないようにしてください。不慮の傷害を避けるために、レー

ザーから安全な距離を取ってください。 

➢ 3Dプリンティングモジュールを使用する場合、ヒーティングロッドの最高温度

が 250℃まで上がるので、ご注意ください！ 

➢ Dobot作動中には、操作ゾーンに手を入れないでください。打撲および/または挫

傷を起こす恐れがありますので、絶対に試さないでください。 

4. More Materials 

Follow us to get first-hand material about Dobot Magician: 

Tutorial: http://dobot.cc/tutorial/ 

Download Center: http://dobot.cc/download-center/ 

その他 

私たちをフォローし、Dobot Magicianに関する最新の情報を手に入れましょう： 

http://dobot.cc/tutorial/
http://dobot.cc/download-center/
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チュートリアル：http://dobot.cc/tutorial/ 

ダウンロードセンター：http://dobot.cc/download-center/ 

5. DobotStudio platforms: Windows XP (DobotStudio does not support using Blockly function 

and Leapmotion function in Windows XP), win7 SP1 x32/x64, win8/win10, mac osx10.10 

and mac osx10.11, mac osx10.12. 

Dobot Magician対応OS：Windows XP (DobotStudioはWindows XPに搭載されるBlockly

機能と Leapmotion 機能に対応していません)、 win7 SP1 x32/x64、 win8/win10、 mac 

osx10.10、mac osx10.11、 mac osx10.12。 

6. Should you have any further questions, feel free to email us at support@dobot.cc 

その他ご不明な点がございましたら、お気軽に support@dobot.ccまでお問い合わせく

ださい。 

http://dobot.cc/tutorial/
http://dobot.cc/download-center/
mailto:support@dobot.cc
mailto:support@dobot.cc
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1. Dobot Magician Driver Installation Instruction Dobot 

Magician ドライバのインストール手順 

When first connecting the Dobot, connect the Dobot to PC through the USB port. Then, power on 

the Dobot, then the system will recognize the corressponding hardware automatically and will 

search for the correct driver and install it. However, if it fails to install, you can install it again 

manually. The installation flow chart as follows:  

最初にDobotを接続するときは、USBポートでDobotを PCに接続してください。その後、

Dobotの電源を入れれば、システムが該当するハードウェアを自動的に認識し、適切なド

ライバを検索し、インストールします。ただし、インストールに失敗した場合は、手動で

再度インストールすることができます。 インストールの流れは次の通りです。 

 

 

1.1 Download CH340 driver package and install it  CH340 ドライバ

パッケージをダウンロードし、インストールする 

There are two versions of the driver based on Windows/Linux, so please choose the 

corressponding version to your OS to download. The driver can be located at the download 

address： 

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download 

After downloading, unzip and install the driver. The driver file is in the file attachment of root 

directory: 

Windows / Linuxに基づいき、2つのドライババージョンがありますので、お使いの OS に

対応するバージョンを選択し、ダウンロードしてください。下記のアドレスでダウンロー

ドしてください： 

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download 

ダウンロード後、ドライバを解凍し、インストールしてください。 ドライバファイルは

ルートディレクトリの添付ファイルにあります： 

Download driver package and 
install it

Check if the equipment work 
properly or not

ライバパッケージをダウン
ロードし、インストールす

る

設備が正常に動作するかど
うかを確認する

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download
http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download
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Figure 1.1 Driver file 図 1.1 ドライバファイル 

 

For example, on Windows, enter into the subfolder 

CH341SER_WIN->CH341SERCH341SER. Double click SETUP.exe and install it, as follows:  

例として、Windowsでは、サブフォルダCH341SER_WIN->CH341SERCH341SERを開き、

SETUP.exeをダブルクリックしてインストールを始めてください： 

 

Figure 1.2 Install driver 図 1.2 ドライバをインストールする 
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Click Install: 

Installをクリックします： 

 

Figure 1.3 Click Install 図 1.3インストールをクリックする 

 

 

Figure 1.4 the driver was installed successfully 図 1.4 ドライバが正常にインストールされました 
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1.2 Check if the equipment can work properly in the device manager 

設備が正常に動作するかどうかを確認する 

1.2.1 Open the device manager and if you can find the corresponding COM port of 

“USB-SERIAL CH340”, then it shows the driver is installed successfully. The correct installation 

is shown below: 

デバイスマネージャーを開いてください。もし USB-SERIAL CH340に対応する COMポ

ートを見つけることができれば、ドライバが正常にインストールされたことになります。

成功した場合は下図のようになります： 

 

Figure 1.5 The COM port in the device management 図 1.5デバイスマネージャーにある COMポート 
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2. DobotStudio Operating Instructions DobotStudioの操作方法 

The software used by Dobot Magician is DobotStudio, and you can download the latest version 

from our official website: 

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download 

After the file successfully downloads, unzip and double click DobotStudio.exe. Then, open the 

software. The result should be as follows: 

Dobot Magicianの制御ソフトウェア DobotStudioは公式のWebサイトから最新バージョン

をダウンロードできます： 

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download 

正常にダウンロードされたファイルを解凍し、DobotStudio.exeをダブルクリックします。 

次に、ソフトウェアを起動します。結果は下図のようになります： 

 

Figure 2.1 DobotStudio file  DobotStudioファイル 

http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download
http://www.dobot.cc/downloadcenter.html?sub_cat=70#sub-download
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Figure 2.2  DobotStudio  

Note: There may be small errors when opening DobotStudio, as shown below:  

注意：DobotStudio を起動する時、下図のように小さなエラーが発生することがありま

す： 

 

Figure 2.3 An error screen when open DobotStudio  DobotStudio起動時のエラー画面 

Please right-click the DobotStudio icon and choose to run the software as administrator. 

DobotStudioアイコンを右クリックし、「管理者としてを実行する」を選択し、ソフトウ

ェアを起動してください。 

 

1. Select the corresponding Dobot serial port, by the top left corner of DobotStudio, and click 

“Connect”. After a successful connection, “Disconnect” will be shown. When the Dobot is 

connected, the coordinate parameters will be updated on the right side of the interface as 

shown below:  

RobotStudio の左上隅で対応する Dobot シリアルポートを選択し、「Connect」をクリ

ックしてください。接続に成功すると、「Disconnect」ボタンが表示されます。Dobot

が接続されると、下図のように、インターフェイスの右側に座標パラメータが更新さ
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れます： 

 

Figure 2.4  Connected successfully 

There are eight modules on the main software interface: 

（1）Teaching & Playback: A system to teach the Dobot how to move. It enables the Dobot to 

accomplish recorded movements by manual control. 

（2）Write & Draw: Controls the Dobot to write, draw or laser engrave.  

（3）DobotBlockly：Teaches basic programming through a puzzle interface. Intuitive and easy to 

understand. 

（4）Script: Edit scripting language to control the Dobot. 

（5）LeapMotion: Control the Dobot by gesture.  

（6）Mouse: Control the Dobot by mouse. 

（7）LaserEngraving: Engraves images, shapes, and words through bitmap with the Dobot. 

（8）Add More: Add even more functions for the Dobot! 

メインソフトウェアインターフェイスには 8つのモジュールがあります。 

（1） ティーチング＆プレイバック：Dobotに移動方法を教えるシステムです。これに

より、Dobotが手動制御により記録された動きをプレイバックできるようになり

ます。 

（2） ライティング＆ドローイング：Dobotを制御し、ライティング、ドローイング、

またはレーザー彫刻を行います。 

（3） DobotBlockly：パズルインターフェイスを介して基本的なプログラミングを教え

ることができます。 直感的でわかりやすい。 

（4） スクリプト：スクリプト言語を編集し、Dobotを制御します。 

（5） LeapMotion：ジェスチャーにより Dobotを制御します。 

（6） マウス：マウスにより Dobotを制御します。 

（7） レーザー彫刻：Dobotを用いてビットマップの画像、図形および文字を彫刻しま

す。 

（8） 機能追加：Dobotにさらなる機能を追加しましょう！ 

Here we will introduce Teaching & Playback at first. 

Click Teaching & Playback, the brief introduction of each area as follows: 
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最初に、ティーチング＆プレイバック機能をご紹介します 

「Teaching&playback」をクリックし、各エリアに対する簡単な紹介が表示されます： 

 

 

Figure 2.5 The main interface of teaching & playback ティーチング＆プレイバックのメインインター

フェイス 

Area 2： 

Here comes with Dobot movement area, linear mode and jog mode.  

Linear mode: Based on the body axes coordinate system X, Y, Z with the origin at the  

center of three motors. X, Y, Z is the coordinate of the center of the end platform, and  

the direction of X is perpendicular to the base forward, Y is perpendicular to the base  

towards the left, and Z is vertical upward. R indicates the rotation of the servo joint  

relative to the coordinate frame (counter-clockwise is the positive direction).  

エリア 2： 
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ここで、Dobotの移動区域、リニアモードおよびジョグモードが表示されています。 

リニアモード：3つのモータの中心を原点とする座標系 X、Y、Zに基づいています。X、

Y、Z は、終端プラットフォームの中心座標であり、X の方向はベースの前方に対し

て垂直で前方向き、Yの方向はベースに対して垂直で左向き、Zの方向は垂直で上向

きです。Rはサーボジョイントが座標系への相対的な回転を示します（反時計回りを

正の方向とします）。 

 

Figure 2.6 Coordinate system 座標系 

（1） Click X+,X- and Dobot will move along X in the negative or positive direction; 

（2） Click Y+,Y- and Dobot will move along Y in the negative or positive direction; 

（3） Click Z+,Z- and Dobot will move along Z in the negative or positive direction; 

（4） Click R+,R- and Dobot will move along R in the negative or positive direction. 

(1)  X+、X-をクリックすると、Dobotは X に沿って負または正の方向に移動します。 

(2)  Y+、Y-をクリックすると、Dobotは Y に沿って負または正の方向に移動します。 

(3)  Z+、Z-をクリックすると、Dobotは Zに沿って負または正の方向に移動します。 

(4)  R+、R-をクリックすると、Dobotは R に沿って負または正の方向に移動します。 

 

Note: 

The R-axis will move together with Y-axis during the movements, so make sure the terminal 

posture relative to the origin of coordinates stays constant.  

注意： 

R軸は移動中に Y軸と共に移動するので、末端が座標原点への相対的な姿勢が一定に保

たれていることを確保してください。 

 

Jog mode：This movement is aimed for a single axis. Hold down the button, and the 

corresponding axis will move independently. Once the axis is maxed out, the joint will stop 

moving. Each axis has counterclockwise as the positive direction. Joint1、2、3、4 refer to base, rear 

arm, forearm and servo respectively. 
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ジョグモード：この動きの制御対象は各単一の軸です。ボタンを押し続けると、対応する

軸が単独で動きます。動きの限度に達すると、ジョイントも止まります。各軸は反時計回

りを正の方向としています。Joint1、2、3、4はそれぞれベース、リアアーム、フォアア

ームとサーボを指します。 

 

Figure 2.7 Single axis coordinate system 単軸座標系 

（1） Click Joint1+、Joint1- and control the Dobot base motor to rotate in the negative or 

positive direction; 

（2） Click Joint2+、Joint2- and control rear arm motor to rotate in the negative or positive 

direction; 

（3） Click Joint3+、Joint3- and control forearm motor to rotate in the negative or positive 

direction; 

（4） Click Joint4+、Joint4- and control servor to rotate in the negative or positive direction; 

Among this, the rotation range of Joint4 is ±150°. 

(1) Joint1+、Joint1-をクリックすると、Dobotのベースモータを負方向または正方向に回

転させることができます。 

(2) Joint2+、Joint2-をクリックすると、Dobotのリアアームモータを負方向または正方向

に回転させることができます。 

(3) Joint3+、Joint3-をクリックすると、Dobotのフォアアームモータを負方向または正方

向に回転させることができます。 

(4) Joint4+、Joint4-をクリックすると、Dobotのサーボを負方向または正方向に回転させ

ることができます。 

その内、Joint4の回転範囲は±150°です。 

Pen/Gripper/SuctionCup/Laser： 

Through choosing the corresponding buttons, open gripper/suction cup/laser. 

ペン/グリッパー/吸盤/レーザー： 

対応するボタンを選択することにより、 

グリッパー/吸盤/レーザーをアクティブ化できます。 



 

 

                                       
  

21 

 

Dobot Magician ユーザーマニュアル 

 

 

 

Figure 2.8 Select End Effector エンドエフェクタを選択します 

 

You can also customize the End Effector Configuration according to the relative coordinate of 

the terminal center. The central terminal is shown as follows: 

また、末端中心の相対座標に従ってエンドエフェクタの配置データをカスタマイズするこ

ともできます。末端中心は下図のようになります。 
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Figure 2.9 The central terminal 末端中心 

 

Speed：Adjust the ratio bar to change the velocity ratio of the movement of the jog control. The 

movement velocity is calculated by multiplying the corresponding percentage. Click Settings in 

Area 3 to get a fast adjustment of parameters.  

速度：比率バーを調整し、ジョグ制御による動きの速度比を変更できます。移動速度は、

対応するパーセンテージを掛けることによって算出されています。エリア 3 にある

「Settings」ボタンをクリックし、パラメータを手軽に調整することができます。 

 

Area 1： 

Home：The Dobot will automatically reset to it original neutral position. When this button is 

pressed, the Dobot will rotate back to its preset home position. In this process, the Home point 

can be self-defined, which will be explained in area 5. 

Emergency Stop：Automatically stops all processes. 

エリア 1： 

ホーム：Dobot は自動的に元の中立位置にリセットします。このボタンを押すと、Dobot

は元のホームポジションに戻ります。このプロセスでは、ホームポイントはカスタマ

イズできます。詳細はエリア 5で説明します。 

緊急停止：自動的に全プロセスを停止します。 

 

Area 3： 

New/ Open/Save：Create / Open / Save point list. 

Start/stop: Start / Stop playback motions. 

Click Start to start from the beginning. (The button will now change into Pause.) Click Pause 

when the dobot moves, and the button will change into Resume. Click Resume and it will 

continue to move.  

Loop: Set how many times the playback will loop. 

Easy/Pro：Mode switch, including offline mode and I/O settings, and refer to the detailed tutorial: 

The tutorial of advanced functions.  
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Speed/Acc: Detailed parameter configuration of playback speed and acceleration. 

Settings：Set movement parameters. 

You can also set the velocity and acceleration of single joint. 

エリア 3： 

New/ Open/Save：ポイントリストを新規作成/開き/保存します。 

Start/stop：動作プレイバックを開始/停止します。 

「Start」をクリックすると、動作が最初から開始します。（同時に、ボタンが「Pause」

に変わります）。Dobot 動作中に Pause をクリックすると、ボタンが「Resume」に変わ

ります。「Resume」をクリックすると動作再開になります。 

Loop：動作再現がループする回数を設定します。 

Easy/Pro：モードスイッチボタン、オフラインモードと I / O設定を含みます。詳細は拡

張機能チュートリアルを参照してください 

Speed / ACC：再現速度と加速に関するの詳細なパラメータ設定です。 

Settings：移動パラメータを設定します。 

また、シングルジョイントの速度と加速度を設定することもできます。 

 

Figure 2.10 Parameters of single joint movement シングルジョイントの移動パラメータ 

 

Set velocity and acceleration of coordinates: 

座標系の速度と加速度を設定します： 
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Figure 2.11 Parameter settings of coordinates 座標系のパラメータ設定 

 

The height and Z limit of Jump mode: 

ジャンプモードの高さと高さ制限（Z limit）： 

 

图 2.12 Jump mode settings ジャンプモードの設定 

 

Handhold teaching: Tick the function says, “Enable Handhold Teaching”. Then, press and hold 

down Unlock on the forearm and drag the Dobot to any position. You can save a point after letting 
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go of the Unlock button. Of course, you can save points continuously. After all the points are 

recorded, Dobot will be able to play back the programmed trajectories.  

手を取って教える：「手を取って教える機能を有効にする」にチェックを入れてくださ

い。次に、フォアアームにある「ロック解除」ボタンを押し続けながら Dobotを任意の位

置にドラッグしてください。その時、「ロック解除」ボタンを放すと 1つのポイントが保

存されます。もちろん、継続的にポイントを保存することもできます。すべてのポイント

が記録された後、Dobotはプログラムされた軌跡を再現することができます。 

 

图 2.13 Playback settings プレイバック設置 

 

Area 4：Select save mode.  

1. Click +Point, you can save the current point information in area 5.  

2. PTP Point：Point mode, and three modes between saved points, JUMP、MOVJ、MOVL 

respectively. 

JUMP： From point A to point B, the trajectory is shown below, the end effector will lift   

upwards by amount of Height (in mm) and move horizontally to a point that is above B by  

Height and then move down to Point B.  

エリア 4：保存モードを選択します。 

1.  +Pointをクリックすると、エリア 5にある現在のポイント情報を保存することができ

ます。 

2. PTP Point：ポイントモードであり、保存済みポイントの間にそれぞれ JUMP、MOVJ、

MOVLという 3つのモードがあります。 

JUMP：ポイントAからポイント Bまでの JUMP運動軌跡が下図のようになります。

エンドエフェクタは一定の高さ（mm単位）まで上昇し、ポイント B 上方同じ高さのとこ

ろまで水平移動し、最後にポイント Bまで下降します。 
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Figure 2.14 JUMP Mode JUMP モード 

 

   MOVJ：Joint movements. From point A to point B, each joint will run from initial angle to  

   its target angle, regardless of the trajectory. The motion time for all joints are the same which  

   means all joints will start and finish at the same time.  

     MOVL：The joints will perform a straight line trajectory from point A to    

     point B.  

MOVJ：ジョイント運動です。ポイント A からポイント Bまで、各ジョイントは軌道に

かかわらず、最初の角度から目標角度まで移動します。すべてのジョイントの移動時間は

同じですので、すべてのジョイントが同時に移動を始め、そして同時に移動を終了するこ

とになります。 

MOVL：ジョイントは、ポイント Aからポイント B まで直線軌道に沿って移動します。 

                       

Figure 2.15 MOVL/MOVJ Mode  MOVL/MOVJモード 

 

3. Pause Time：The pause unit of time is 1 second.  

4. CP Point：Track points, saved points between velocity and acc transmit smoothly. 

3. Pause Time：一時停止の単位時間は 1秒です。 

4. CP Point：線路ポイントであり、速度と加速度の間の保存済みポイントをスムーズに

繋がります。 

 

Area 5：Playback list that can be edited. 
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To show the current endeffector coordinates, Move Mode, pause time and any other parameters, 

double click to edit every single saved point coordinate. You can also edit from the sidebar on the 

left side or press right –hand button: 

エリア 5：編集可能なプレイバックリスト。 

現在のエンフェクタ座標、運動モード、一時停止時間およびその他のパラメータを表示し

ています。ダブルクリックして保存済みポイント座標を 1つずつ編集することができます。

左側のサイドバーから編集することも、または右クリックして編集することもできます： 

 

Figure 2.16 Right click options of the saved point list 保存済みポイントの右クリックオプション 

1. MotionStyle：JUMP、MOVJ、MOVL. 

2. X, Y, Z is the coordinate of the center of the end platform. 

3. RHead indicates the rotation of the servo joint relative to the coordinate frame 

(counter-clockwise is the positive direction). 

4. PauseTime. 

5. Insert：Insert a line of saved points.  

6. MoveUp/MoveDown: Move up/Move down the line of saved point.  

7. Delete：Delete selected saved points。 

8. DeleteAll: Delete all saved points.  

9. RunSeleted: Execute selected points.  

10. Overwrite：Overwrite current saved points.  

11. SetHome:Set as Home point location. 

1. 1. MotionStyle：JUMP、MOVJ、MOVL。 

2. X、Y、Zは、エンドプラットフォームの中心座標です。 

3. RHead はサーボジョイントが座標系への相対的な回転を示します（反時計回りを正の

方向とします）。 

4. PauseTime 一時停止時間 

5. Insert：保存済みポイントを 1行挿入します。 

6. MoveUp/MoveDown：保存済みポイントの行を上、下に移動します。 

7. Delete：選定された保存済みポイントを削除します。 

8. DeleteAll：すべての保存済みポイントを削除します。 

9. RunSeleted：選定されたポイントを実行します。 

10. Overwrite：現在保存されているポイントを上書きします。 

11.SetHome：ホームポイントとして設定します。 



 

 

                                       
  

28 

 

Dobot Magician ユーザーマニュアル 

 

3. Teaching & Playback ティーチング＆プレイバック 

Here we will learn how to suck up or grab simple objects using the function of Teaching & 

Playback. Because we need to use the air pump kit for the suction cup and the gripper kit, we will 

introduce these two kits together. 

ここで、ティーチング＆プレイバック機能を用いて、単純なオブジェクトを吸い上げ·つ

かむ方法をご紹介します。吸盤向けエアーポンプキット、およびグリッパーキットが必要

になりますので、この 2つのキットも合わせてご紹介します。 

3.1 Air pump kit エアーポンプキット 

The default installation of the Dobot Magician is the suction cup. The pump box and 

suction cup kit is shown below: 

Dobot Magicianはデフォルトで吸盤が取付られています。ポンプボックスと吸盤キットは

下図に示しています。 

 

Figure 3.1 Air pump kit エアーポンプキット 

Installation Steps: 

1. Connect power line SW1 on the pump box with interface SW1 on the controller box, connect 

signal line with interface GP1; 

2. Tighten air pump kit into the end of the socket with butterfly nut; 

3. Connect windpipe on the controller box with pipe connector on the pump box;  

4. Connect GP3 of Joint4 servo line with forearm connector①GP3. 

The installation effect as follows: 

取付手順： 

1. ポンプボックスの電源ライン SW1をコントローラボックス上のインターフェイス

SW1に接続し、信号ラインをインターフェイス GP1 に接続します； 

2.ちょうナットを用いてエアーポンプキットをソケットの端に締め付けます； 

3. コントローラーボックスの風管をポンプボックスのパイプコネクターに接続します； 

4．ジョイント 4サーボラインの GP3とフォアアームコネクター①GP3 に接続します； 
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取付後の状態は下図のようになります： 

 

Figure 3.2 The installation effect of air pump kit エアポンプキットの取付完成図 

3.2 Pneumatic Gripper Kit 空気式グリッパーキット 

1. Pneumatic accessories are shown in following picture: 

空気圧部品は下図に示されています:

 

Figure 3.3 Pneumatic Gripper Kit 空気式グリッパーキット 

2. The gripper kit shares the air pump kit of suction cup. You can remove the suction cup from 

Joint4. Unscrew the fixed on the suction cup with the hex wrench, shown in Figure 3.4: 

グリッパーキットはエアーポンプキットに使われる吸盤も利用しています。Joint 4か

ら吸盤を取り外すことができます。図 3.4 に示すように、六角レンチを用いて吸盤の

固定具を外します。 
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Figure 3.4 Remove suction cup 吸盤を取り外す 

3. Install the gripper kit on Joint4 with the coupler, as shown in Figure 2.5:  

図 3.5に示すように、カプラを用いて Joint4にグリッパーキットを取り付けます： 

 

Figure 3.5 Gripper Installation グリッパー取付 

 

4. The connection method of gripper is the same with air pump kit. You can refer to air pump kit 

method above.  

5. The installation effect of gripper kit as follows: 

4.グリッパーの接続方法はエアーポンプキットと同じです。 上記のエアーポンプキット

の方法を参照してください。 

JackScrew 
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5.グリッパーキット取付後の状態は下図のようになります： 

 

Figure 3.6  Gripper Installation グリッパー取付 

3.3 Demo of Teaching & Playback ティーチング＆プレイバックの

デモ 

After learning about the software, now we can try to make Dobot Magician move. Through the 

function of Teaching & Playback, we can make it move a small object.  

1. Select the terminal tool as SuctionCup on the software interface and select JUMP mode.  

2. Place a small object nearby and move the Dobot above the small object. Click Area 2, tick 

SuctionCup and open the pump. The small object will be sucked up. 

3. Click +Point and save a point. 

4. Click Z+ to raise the Dobot and move the arm to another position. Place the small object on 

the table, uncheck SuctionCup, and close the pump. 

5. Click +Point and save one more point. 

6. Put back the small object and click Start. Our task for moving the object from the current 

location to another location has been completed successfully. 

ソフトウェアの使い方がお分かりになった後、今度は Dobot Magicianを動かすことを実践

します。ティーチング＆プレイバック機能を用いて、小さなオブジェクトを動かすことが

できます。 

1.ソフトウェアインターフェイスで末端ツールを「SuctionCup」に選択し、そして「JUMP」

モードを選択してください。 

2. 小さなオブジェクトを近くに置き、小さなオブジェクトの上方まで Dobot を移動して

ください。「Area 2」をクリックし、「SuctionCup」にチェックを入れ、ポンプを起動し

ます。そうすると、小さいオブジェクトが吸い上げられます。 

3.「+Point」をクリックし、1 つのポイントを保存します。 

4．「Z+」をクリックして Dobotを上昇させ、アームを別の位置に動かします。小さなオ

ブジェクトをテーブルに置き、「SuctionCup」のチェックを外し、ポンプを閉じてくださ

い。 

5. 「+Point」をクリックし、もう 1つのポイントを保存します。 

6. 小さなオブジェクトを元の位置に戻し、「Start」をクリックしてください。オブジェ

クトを現在の位置から別の位置に移動する作業が正常に完了しました。 
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4. Advanced function of Teaching&Playback 

ティーチング＆プレイバックの拡張機能 

You can switch Easily into Pro when pressing the button “Easy/Pro”, as shown below: 

下図に示すように、「Easy/Pro」ボタンを押すと簡単モードをプロモードに切り替えるこ

とができます： 

 

Figure 4.1  Advanced function of teaching&playback ティーチング＆プレイバックの拡張機能 

4.1 StepRun ステップラン 

1. StepRun: StepRun allows you to execute one command at a time. Pressing it once executes 

the first motion, and subsequent presses will execute commands down the list one at a time. 

ステップラン：ステップラン機能を用いて、一度に 1 つのコマンドを実行できます。

第 1回目に押すと最初の動作が実行されます。その後、ボタンを押すたびに、リスト

に乗っているコマンドが順番通りに 1つずつ実行されます。 

 

Figure 4.2  StepRun ステップラン 

2. Click Stop and then you can exit the mode of StepRun. 

「Stop」ボタンをクリックし、ステップランモードを終了することができます。 
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4.2 Offline mode オフラインモード 

1. Click Download to download the current saved points list into the Dobot. A USB cable will 

not be needed for use.  

「Download」をクリックし、現在保存済みポイントリストを Dobotにダウンロードし

ます。これで、USBケーブルなしに保存済みポイントを実行できます。 

 

Figure 4.3 Download saved point list 保存されているポイントリストをダウンロードする 

 

2. After downloading, pull out the USB cable, press Key behind the controller box, and execute 

the downloaded program. The program will stop executing when it is pressed again. 

ダウンロード終了後、USB ケーブルを取り外し、コントローラボックスの背後にある

「Key」を押してダウンロードしたプログラムを実行します。もう一度押すと実行中

止になります。 

 

Figure 4.4 Offline mode button オフラインモードボタン 

 

Note: Before offline mode can be used, the Dobot needs to be reset by pressing Home. Switch on 

the Dobot, wait 20 seconds after the green light is on, and click Home when the sensor is stable. 
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1) The blue light will flash during homing. It is completely normal for that to happen. Do not 

operate the Dobot until the green light is on. 

2) After homing, you can save points and then download. Click OK in the dialog box. 

注意：オフラインモードを使用する前に、「Home」ボタンを押して Dobotをリセッ

トする必要があります。Dobotをオンにし、ランプが緑色点灯してから 20秒後、セン

サーが安定している状態になると「Home」ボタンを押してください。 

1) ホーミングプロセス中に青色ランプが点滅します。それが正常な状態です。ランプが

緑色点灯するまで、Dobotを操作しないでください。 

2) ホーミングプロセス終了後、ポイントを保存し、ダウンロードすることができます。

ダイアログボックス中の「OK」をクリックしてください。 

 

 

Playback steps: 

Switch on the Dobot, wait 20 seconds after the green light is on, and then click Key to move 

offline when the sensor is stable. 

プレイバックステップ：Dobotをオンにし、ランプが緑色点灯してから 20秒後、センサ

ーが安定している状態になると「Key」ボタンを押してオフラインで Dobotを動かしてく

ださい。 

 

4.3 EIO multiplex EIO多重化機能 

The EIO (Extended I/O) in Dobot has multiple functions and uses. This chapter aims to address all 

the functions for DobotV2.0 EIO.  

The EIO interface of advanced functions is shown below: 

Dobotの EIO（拡張 I / O）は、複数の機能と用途があります。 この章では、DobotV2.0 EIO

のすべての機能に対するアドレス指定を行うことを目的としています。 

拡張機能の EIO インターフェイスは下図に示しています： 
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Figure 4.5  EIO Interface EIO インターフェイス 

 

4.3.1 EIO locations EIO ロケーション 

EIO are located near the base and forearm separately in DobotV2.0.  

DobotV2.0.において、EIOは別々にベースとフォアアームインターフェイスに位置してい

ます。 

1）EIO located in the forearm are shown below: 

フォアアームインターフェイスにある EIO は下図に示しています： 

 

Figure 4.6  EIO addressing in forearm フォアアームにある EIO アドレス方式 
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2）EIO located in the base 18PIN interface board are shown below: 

ベース 18ピンインターフェイスにある EIO は下図に示しています： 

 

Figure 4.7  EIO addressing in base 18PIN ベース 18ピンにある EIOアドレス方式 

 

3）EIO located in the base 10PIN interface board are shown below: 

ベース 10ピンインターフェイスにある EIO は下図に示しています： 

 
Figure 4.8 EIO addressing in base 10PIN ベース 10ピンにある EIO アドレス方式 

 

4.3.2 EIO multiplex function  EIO多重化機能 

Now let’s describe the EIO multiplex function. (Depending on hardware) 

次に、EIO 多重化機能についてご紹介します。 （ハードウェアによって異なります） 

1）EIO multiplex instruction of forearm interface board, as shown below: 

フォアアームインターフェイスボードにある EIO 多重化に対する説明は、下表に示して

います。 

Figure 4.1  EIO multiplex instruction of forearm interface board 

フォアアームインターフェイスボードにある EIO多重化に対する説明 
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2）EIO multiplex instruction of 18PIN interface board on the base, as shown below: 

ベース 18ピンインターフェイスにある EIO多重化に対する説明は、下表に示しています。 

Figure 4.2 EIO multiplex instruction of 18PIN interface board on the base 

ベース 18ピンインターフェイスにある EIO多重化に対する説明 

3） EIO multiplex instruction of 10PIN interface board on the base, as shown below:  

ベース 10ピンインターフェイスにある EIO多重化に対する説明は、下表に示しています。 

Figure 4.3  EIO multiplex instruction of 18PIN interface board on the base  

ベース 10ピンインターフェイスにある EIO多重化に対する説明 

 

4.3.3 EIO multiplex Demo EIO 多重化デモ 

Selected corresponding EIO, set input/output condition, and then you can multiplex each unique 

EIO. Here we have detailed explanation of level output, level input, ADC input and PWM output.  

対応する EIO を選択し、入力/出力条件を設定することにより、各 EIOを多重化すること

ができます。ここで、レベル出力、レベル入力、ADC入力、および PWM出力に対する

詳細な説明を行います。 

1） Level Output 

EIO 

addressing 

Level Range Level 

Output 

PWM Level Input ADC 

O1 3.3V √  √ √ 

O2 12V √    

O3 12V √    

O4 3.3V √ √ √  

O5 3.3V √  √ √ 

O6 3.3V √ √ √  

O7 3.3V √  √ √ 

O8 3.3V √ √ √  

O9 3.3V √  √ √ 

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

10 5V √    

11 3.3V √ √ √  

12 3.3V √  √ √ 

13 5V √    

14 3.3V √ √ √  

15 3.3V √  √ √ 

16 12V √    

17 12V √    

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

18 3.3V √  √  

19 3.3V √  √  

20 3.3V √  √  



 

 

                                       
  

38 

 

Dobot Magician ユーザーマニュアル 

 

Take EIO01 on the forearm connector for an example, it can configure level output into 3.3V. 

Shown as follows: 

レベル出力 

フォアアームコネクタにある EIO 01 を例として説明します。下表のように、レベル出力

を 3.3Vに設定ですることができます： 

 

Tick IO_1(in the output option) -> tick Value, -> +Point, and then it can be configured into 

high-level output of 3.3V(If you don’t tick it, please choose low-level output).  

出力オプションにある「IO_1」にチェックを入れ->「Value」にチェックを入れ->「+Point」

をクリックすることにより、3.3V の高レベル出力に設定されることになります（チェッ

クを入れない場合は、低レベルの出力になります）。 

 

 

Figure 4.9  High level output of EIO1 demo  EIO1デモの高レベル出力 

2） Level input 

Also, take EIO01 on the forearm connector for an example, if you get an external 

photoelectric sensor, it will trigger Dobot move and can be configured into low/high level 

input trigger mode when access to an inductive object. Select trigger point->EIO1_Input 

(Trigger area on the bottom right)-> Condition=1->add ADD key. Cancel key can delete 

trigger settings of the current point. Trigger Value=0 denotes a low level and Value=1 denotes 

a high level. 

レベル入力 

同様に、フォアアームコネクタ上の EIO01を例として説明します。外部の光電センサ

ーを設備に接続すれば、それが物体を探知した場合、Dobotの動きを誘発し、低/高レ

ベルの入力トリガモードに設定されることができます。トリガポイントを選択- > 

「EIO1_Input」（右下のトリガーエリアにある） - > Condition = 1-> ADDボタンを

追加します。キャンセルボタンは、現在ポイントのトリガ設定を削除することができ

ます。トリガ値= 0 は低レベルを示し、値= 1 は高レベルを示す。 

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

O1 3.3V √  √ √ 



 

 

                                       
  

39 

 

Dobot Magician ユーザーマニュアル 

 

 

Figure 4.10 High level output of EIO1 demo  EIO1デモの高レベル出力 

 

3） ADC input 

ADC input operational method is the same with level input. Select configured saved point and 

pins of the ADC (such as EIO1), set ADC value less than 200, and click ADD key to finish. The 

trigger value settings range is from 0 to 4095. 

ADC入力 

ADC 入力の操作方法はレベル入力と同じです。ADC の設定·保存済みポイントとピン

（EIO1 など）を選択し、ADC 値を 200 未満に設定し、「ADD」をクリックして終了し

ます。トリガ値の設定範囲は 0〜4095です。 

 

Figure 4.11  EIO1  ADC input demo ADC 入力デモ 

 

4） PWM Output 

PWM: Take EIO4 for a demo 

PWM出力 

PWM：EIO4をデモとして取り上げます。 

 

EIO 

Addressing 

Level Range Level 

Output 

PWM Level Input ADC 

O4 3.3V √ √ √  
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Tick IO_4 pin in the Output area, click +Point to save new points, double click EIO4 table cell, 

select “…” in the drop-down box, and set Frequency, unit of KHZ，10HZ-1MHZ and 

DutyRatio（0-100%) in the pop-up dialog, as shown below: 

以下のように、出力エリアで IO_4ピンにチェックを入れ、「+Point」をクリックして新

ポイントを保存し、EIO4テーブルセルをダブルクリックし、ドロップダウンボックスで

「…」を選択し、ポップアップダイアログでの周波数、KHZの単位、10HZ-1MHZおよ

びデューティ比（0－100%）を設定します。 
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Figure 4.12 EIO4  PWM output demo EIO4 PWM出力デモ 

 

Above is the four multiplex demo. 

4つの多重化デモが以上になります。 
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5. Write & Draw Manual ライティング＆ドローイング

マニュアル 

The whole flow chart as follows: 

全体の流れは以下の通りです： 

 

5.1 Installation of writing accessories ライディングアクセサリーの取付 

A pen and pen holder included in the Write & Draw kit. The steps to install are as follows: 

1. Install the pen into the fixture; 

2. Lock the fixture into the end-effector with butterfly nut. 

ライティング＆ドローイングキットにはペン 1 つとペンホルダー1 つが含まれています。

取付手順が以下の通りです： 

1. ペンを固定具に取り付けます； 

2.ちょうナットで固定具をエンドエフェクタに固定します。 

 

Figure 5.1   Installation of pen ぺんの取付 

 

If you want to change the pen, just loosen the four screws on the pen holder. 

ペンを交換する場合は、ペンホルダーを固定する 4本のネジを緩めてください。 

Pen 
Installation

Connect 
DobotStudio

Import 
pictures and 
set params

Adjust the 
position and 

start to write

ペンの取付
DobotStudioへ
接続する

画像を取り込
み、パラメー
タを設定する

位置を調整し、
書き始める
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Figure 5.2 Pen installation ぺんの取付 

5.2 Connect DobotStudio  DobotStudioに接続する 

1. The software used by Write & Draw is DobotStudio, and the hardware itself is applicable for 

DobotStudio, so you can connect it directly. Open the software and click the Write & Draw 

module. The interface of Write & Draw is shown below: 

ライティング＆ドローイング機能の制御ソフトウェアは DobotStudio であり、ハード

ウェア自体も DobotStudio に適用可能ですので、直接的に接続することができます。

ソフトウェアを起動し、ライティング＆ドローイングモジュールをクリックしてくだ

さい。ライティング＆ドローイングのインターフェイスは以下に示します。 
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Figure 5.3 Writing & drawing interface ライティング＆ドローイングインターフェイス 

 

2. If the current hardware is not the hardware of Write & Draw itself, there will be a pop up to 

change the firmware. For example, if the current firmware is for 3D printing, there will be a 

pop up for a selected window. Here, we can choose DobotStudio in the drop-down box:  

現在のハードウェアはライティング＆ドローイング用のハードウェアではない場合、

ファームウェア変更用のポップアップが表示されます。例として、現在のファームウ

ェアが 3D プリンティング用のものである場合、切り替え用のポップアップが表示さ

れます。ここで、ドロップダウンボックスで DobotStudioを選択してください。 
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Figure 5.4 Select DobotStudio  DobotStudio を選択する 

 

Then click OK. A pop up window will ask to burn hex. Click Confirm to do so: 

「OK」をクリックしてください。Hexの書き込みを確認するポップアップウィンドウが

表します。「Confirm」をクリックしてください。 

 

After burning, DobotStudio will be opened automatically. Also, after about ten seconds, you will 

hear a short sound from the built-in buzzer, which shows a successful burning. At the same time, 

the light on the bottom right will also turn green. Finally, we can connect Dobot according to the 

above operation.  

書き込み後、DobotStudioは自動的に起動されます。約 10秒後に、内蔵ブザーから短音

が鳴れば、書き込みが成功したことになります。同時に、右下のランプも緑色に変わりま

す。最後に、上記の操作に従って Dobotを接続することができます。 
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5.3 Import pictures and set parameters 画像の取り込みおよびパラメータの設定 

1. The imported picture should be put into the sector area of the main interface, as Dobot will be 

at a limited position if beyond the standard range of motion because of unnatural writing. 

There will be a warning of a red highlighting if beyond range.  

取り込まれた画像は、メインインターフェイスのセクタエリアに置くようにしてくだ

さい。また、標準的な動作範囲を超えた不自然なドローイング軌跡が発生した場合、

Dobotは制限された位置に止まります。範囲を超えていると、赤色でハイランプされ

た警告が表示されます。 

1） Click Open, and import the ready PLT or SVG file:  

「Open」をクリックし、用意したの PLT または SVG ファイルを取り込でください： 

 

Figure 5.5 Open the file ファイルを開く 

 

2） Insert the included pictures of DobotStudio; 

DobotStudioの付属画像を挿入します； 
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Figure 5.6 Insert the included file 付属画像を挿入する 

 

3） Input text manually;  

テキストを手動で入力します； 

 

Figure 5.7 Input text manually テキストを手動で入力する 
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4） You can also import pictures. You need convert these formats（BMP/JPEG/JPG/PNG and so 

on） into SVG (the format recognized by Dobot).  

また、画像を取り込むこともできます。ただし、これらの形式（BMP / JPEG / JPG / PNG

など）を SVG（Dobotが認識する形式）に変換する必要があります。 

 
Figure 5.8 Import pictures 画像を取り込む 

 

After opening the picture, adjust the image to desired size and click Convert Bitmap. The SVG 

path file will come out automatically. Then, click Plot to Main Scene, and the file will be loaded 

in writing main interface, as shown below:  

画像を開いた後、画像を希望のサイズに調整し、「Convert Bitmap」をクリックします。

SVGパスファイルが自動的に出力されます。次に、「Plot to Main Scene」をクッリクす

れば、ファイルはライディングのメインインターフェイスに導入されます： 
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Figure 5.9 Import pictures into SVG files SVGファイルに画像を取り込む 

Set writing parameters: set velocity and acceleration(0~500mm/s) and PenUpOffset;  

ライディングパラメータを設定する：速度と加速度（0〜500mm / s）と「PenUpOffset」

（ぺん持ち上げ高さ）を設定します。 

 

Figure 5.10 Set velocity and acceleration 速度と加速度を設定する 

5.4 Adjust the position and start writing 位置を調整し、ライディングを始める 

1. Set endeffector as Pen. Here, you can choose from Settings->EndEffector, as shown below:  

エンドエフェクタをペンに選択してください。下図のように、「Settings」->「EndEffector」

で選択することができます。 
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Figure 5.11 Set EndEffector エンドエフェクタを設定する 

 

2. Adjust the nib position: press and hold down Unlock key on the forearm and drag the 

forearm to make the nib contact to paper. Also, you can control Z axis moving down to paper 

gradually, shown as follows:  

ペン先の位置を調整する：フォアアームのロック解除キーを押し続け、フォアアーム

をドラッグしてペン先を紙に接触させます。また、下図のように、Z軸を制御し、フ

ォアアームを徐々に用紙向けに移動させることもできます 
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Figure 5.12 Adjust the nib position ペン先の位置を調整する 

 

3. Click AutoZ and get the current Z value. This is so you don’t need to adjust the nib position 

when you write next time. Then, follow these steps: import pictures-> SyncPos->Start to 

start. 

「AutoZ」クリックし、現在の Zバリューを保存します。そうすると、次回のライデ

ィング時にペン先の位置調整が不要になります。次に、「import pictures」->「SyncPos」

->「Start」の順に操作すればライディング作業が開始します。 

 

Figure 5.13 Lock writing height ライディング高さをロックする 

 

You can check the PenDown parameter from here:  

ここで「PenDown」（ペン下ろし）パラメータを確認できます。 

 

Figure 5.14 Pendown parameters ペン下ろしパラメータ 
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If the writing is not very clear, the nib height may need to be adjusted slightly. Revising the value 

of Pendown may also help.  

4. Click SyncPos and the Dobot will move into the top position of writing starting point 

automatically.  

5. Click Start, Pause and Stop to control Dobot. 

6. The result is shown below: 

ライディングがくっきりしていない場合、ペン先の高さを少しづつ調整する必要があ

ります。また、ペン下ろし値を修正することもできます。 

4.「SyncPos」をクリックすれば、Dobotは自動的に開始ポイントの真上に移動します。 

5.「Start」、「Pause」、「Stop」ボタンで Dobotを制御できます。 

6. 結果は以下のようになります： 

 

Figure 5.15 The effect of writing ライディング結果 
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6. Laser Engraving レーザー彫刻 

The entireprocess of laser engraving is as follows: 

レーザー彫刻全体の流れは以下の通りです： 

 

 

Notice: 

Laser engraving and shade laser engraving are different functions. The firmware and upper 

computer used by laser engraving are the same as the ones used in Write & Draw, which can only 

engrave pictures that are composed of a single line. However, shade laser engraving can achieve 

the function of bitmap engraving.(For example, it can engrave figures and head portraits.) If you 

want to use the function of shade laser engraving, please refer to Dobot2.0 Shade Laser 

Engraving. 

注： 

レーザー彫刻とシェードレーザー彫刻は異なる機能です。レーザー彫刻で使用されるファ

ームウェアと上位コンピュータは、ライティング＆ドローイングで使用されるものと同じ、

1行で構成された画像のみ彫刻できます。しかし、シェードレーザー彫刻は、ビットマッ

プ彫刻の機能を実現することができます。（例えば、肖像画を彫刻することができます。）

シェードレーザー彫刻の機能を使用する場合は、Dobot 2.0シェードレーザー彫刻をご参

照ください。 

6.1 Laser Installation レーザーの取付 

1. Fasten the laser by butterfly nut; 

2. Connect 12V power line with interface ⑤SW4 and connect TTL control line with interface 

③GP5.  

 

1．蝶ナットでレーザーを締め付けます。 

2．インターフェース⑤SW4 に 12V 電源線を接続し、インターフェース③GP5 に TTL制

御線を接続します。 

laser installation
Connect 

DobotStudio

Import Pattern 
and Set 

Parameters

Adjust focus 
and

start to engrave

レーザーの取
付

ドボットスタ
ジオと接続す

る

画像の導入と
パラメータの

設置

フォーカスを
調整し、彫刻
開始する
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Figure 6.1  Install Laser レーザーのインストール 

6.2 Connect DobotStudio DobotStudioに接続する 

1. The software used by laser engraving is DobotStudio, so please open the software, click 

Write & Draw, and enter into laser engraving interface, as shown below: 

1．レーザー彫刻で使用されているソフトウェアは DobotStudio です。そのため、このソ

フトウェアを起動し、「Write & Draw」をクリックし、以下表示されるように、レーザ

ー彫刻のインターフェイスに入ります。 
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Figure 6.2 Laser engraving interface レーザー彫刻のインターフェイス 

2. If the current firmware is not for laser engraving, for example, if it is for firmware 3D printing, 

then a pop up dialog will give the option to chooseDobotStudio in the drop-down box: 

2．レーザー彫刻用ファームウェアでない場合は、例えば、ファームウェア 3D プリンテ

ィングの場合、ダイアログがポップアップ表示され、ドロップダウンリストから

「DobotStudio」を選択してください。 
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Figure 6.3 Connect DobotStudio DobotStudiにと接続する 

 

Click OK aand a window will pop up asking to burn hex. Click Confirm to burn hex: 

「OK」をクリックし、書き込む確認用ウィンドウがポップアップ表示され、「Confirm」

をクリックすると、書き込むが開始します。 

 

After burning, DobotStudio will be opened automatically. Also, after about ten seconds, you can 

hear a short sound from built-in buzzer, which shows a successful burning. At the same time, the 

light on the bottom right will turn into green. We can then connect Dobot according to the above 

operation.  

書き込んだ後、DobotStudio が自動的に起動します。10秒後、内臓ブザーから短音がなり、

書き込み完了と示しています。同時に、右下のランプが緑色になります。上記の操作に従

って Dobotに接続することができます。 
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6.3 Import pictures and set parameters 画像の取り込みとパラメータ

の設定 

1） The imported laser engraving file should be put near where the Dobot arm is, as the Dobot 

will be at a limited position if beyond the standard range of motion. There will be a flashing 

red light to warn you if the arm is beyond its natural range.  

1）取り込まれた彫刻ファイルは、Dobotアームの近くに置く必要があります。標準的な

動作範囲を超えた場合、Dobotは制限された位置に止まります。アームが範囲を超えてい

る場合、警告する赤色ランプは点滅します。 

2） Click Open, and import the ready PLT or SVG file:  

2）「Open」をクリックし、用意したの PLT または SVG ファイルを取り込でください。 

 

Figure 6.4 Open PLT File PLTファイルを開く 

 

3）  Insert the included pictures of DobotStudio;  

3）DobotStudio の付属写真を挿入します 
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Figure 6.5 Insert included pictures 写真を挿入する 

 

4）  Input text manually; 

4）テキストを手動で入力します。 

 

Figure 6.6 Input text manually テキストを手動で入力する 

 

5） You can also import pictures. You need convert these formats (BMP/JPEG/JPG/PNG and so 

on) into SVG (the format recognized by Dobot).  

5）また、画像を取り込むこともできます。ただし、これらの形式（BMP / JPEG / JPG 

/ PNG など）を SVG（Dobotが認識する形式）に変換する必要があります。 
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Figure 6.7 Import pictures 画像導入 

 

After opening the picture, set proper switching threshold, click Convert Bitmap.The SVG path 

file will come out automatically. Then, click Plot to Main Scene andthe file can be loaded in 

writing main interface, as shown below: 

画像を開いた後、適切なスイッチング・スレッシュホールドを設定します。「Convert 

Bitmap」をクリックすると、SVGパス名のファイルが自動的に出力されます。次に、「Plot 

to Main Scene」をクリックすると、下図のように、メインインターフェイスに書き込み可

能になります。 

 

Figure 6.8 Import pictures and SVG path file will come out automatically 
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画像を導入し、SVGパス名のファイルが自動的に出力される 

 

1. Set laser engraving parameters: set velocity and acceleration(suggested value is 3 ) and 

PenUpOffset.On here, just keep the default 20; 

1．レーザー彫刻パラメータの設定：速度と加速度を設定し（推奨値：3）、ペン持ち上げ

高さのデフォルト値が 20となっています。 

 

Figure 6.9 Set parameters of laser engraving  

レーザー彫刻のパラメータの設定 

6.4 Adjust the focus and start writing フォーカスを調整し、彫刻を開始す

る 

1. Select the EndEffector as Laser, shown as follows: 

1．下図のように、エンドエフェクタをレーザーに選択します。 
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Figure 6.10 Set EndEffector 

エンドエフェクタの設定 

 

2. Tick ON on the Operation Panel to open the laser; 

2．操作パネルの ON をクリックしてレーザーを起動します。 

 

Figure 6.11Open the laser レーザーを起動する 

 

Focus Adjustment: Hold down theUnlock Key to adjust the distance between laser and the surface 

of the material, and then adjust the knob to focus it properly. It will be at the right height when the 
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laser dot burns the brightest. Burn marks on the paper will be another indicator that you have done 

so correctly. You can turn off the laser by unticking the box after adjusting.  

フォーカスの調整：ロック解除キーを押しながら、レーザーと材料表面の間の距離を調整

し、ノブを適切にフォーカスするように調整します。レーザードットが最も明るくする場

合は、正しい高度を示しています。紙にバーマークがある場合、それが正しく調整したこ

とを示す別の指標となります。調整後、ボックスのチェックを取消し、レーザーをオフに

します。 

 

If it still cannot focus, then the focus of the laser is wrong. We can rotate the metal knob of the 

laser to adjust(as shown on the bottom right) and refocus again.  

それでもフォーカスを合わせることができない場合、レーザーのフォーカスは間違ってい

ます。レーザーのメタルノブを回転させて（右下に示すように）調整し、再びフォーカス

を合わせることができます。 

 

Figure 6.12 Focus Adjustment フォーカス調整 

Notice： 

The laser can heat objects when it is in a focused state, so objects like paper or wood 

can be engraved or burned. 

! DO NOT focus the laser on people or animals 

! DO NOT let children play with it alone.   

! The process needs to be monitored when it is running. 

! After the process, please turn off the laser promptly. 

注意： 

レーザーはフォーカスが合った状態で物体を加熱することができるため、紙や木

などの物体を彫刻したり、燃やしたりすることができます。 

！人や動物にレーザーをフォーカスしないでください。 

！子供たちだけで遊んではいけません。 

！実行中のプロセスを監視する必要があります。 

！操作が終わったら、すぐにレーザーの電源を切ってください。 

3. Click AutoZ and get the current Z value. This way, you do not need to adjust the focus 

manually when you engrave next time. To do so, here are the steps: import pictures-> 

SyncPos->Start. 
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3．「AutoZ」をクリックし、現在の Z値を取得します。これで、次回彫刻時に手動でフ

ォーカスを調整することが不要になります。操作手順は「import pictures」→「SyncPos」

→「Start」となります。 

 

Figure 6.13 Lock writing height ライディング高度をロックする 

You can check the Pendown parameter from here: 

ここでペン下ろしパラメータを確認することができます。 

 

Figure 6.14 Pendown parameters ペン下ろしパラメータ 

 

If the engraving isn’t clear, the laser height needs to be adjusted slightly. Revising the value of 

Pendown also helps. 

4. Click SyncPos, Dobot will move into the top position of the starting point automatically.  

5. Click Start, Pause and Stop to control Dobot. 

6. The effect shown as follows: 
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彫刻が鮮明でない場合は、レーザーの高さをわずかに調整する必要があります。また、ペ

ン下ろし値を再設定することも役立ちます。 

4．「SyncPos」をクリックすれば、Dobot は自動的に開始ポイントの真上に移動します。 

5．「Start」、「Pause」、「Stop」ボタンで Dobotを制御できます。 

6．結果は以下のようになります。 

 

Figure 6.15 The product of laser engraving レーザー彫刻の結果 
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7. The Tutorial of Shade Laser Engraving シェードレーザ

ー彫刻のチュートリアル 

The whole flow chart of shade laser engraving is shown below: 

シェードレーザー彫刻の全体の流れは以下となります。 

 

 

Note: Shade laser engraving is also a kind of laser engraving! 

注：シェードレーザー彫刻もレーザー彫刻の一つです。 

7.1 Installation of Laser Accessories レーザーアクセサリーの取付 

Shade laser engraving and laser engraving share the same kit. Please refer to the chapter pertaining 

to laser engraving installation. 

シェードレーザー彫刻とレーザー彫刻は、同じキットを共有します。レーザー彫刻の設置

に関する章をご参照ください。 

7.2 Connect DobotStudio DobotStudioに接続する 

1. Open DobotStudio and select the EndEffector as Laser. 

1．DobotStudio を起動し、エンドエフェクタをレーザーに選択してください。 

Installation 
of Laser 

Accessories

Connect Grbl 
Controller

Import Pattern 
and Set 

Parameters

Start 
Engraving

レーザーアク
セサリーのイ
ンストール

Grblコントロ
ーラと接続す

る

画像の導入と
パラメータの

設置
彫刻開始
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Figure 7.1 Open laser engraving interface レーザー彫刻のインターフェイスを開く

 

Figure 7.2 Enter the shade laser engraving interface シェードレーザー彫刻のインターフェイスに入る 

 

2. If the current firmware is not for DobotStudio, (for example, 3D printing) a pop up window 

will ask for you to switch. Then, we can select DobotStudio in the drop-down box:  

2．DobotStudio 用ファームウェアでない場合は、例えば、3Dプリンティングの場合、ウ

ィンドウがポップアップ表示され、ドロップダウンリストから「DobotStudio」を選択し

てください。 
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Figure 7.3 Select DobotStudio DobotStudio を選択する 

 

Then click OK, and a window will pop up asking to burn hex. Click Confirm to burn hex: 

「OK」をクリックし、書き込む確認用ウィンドウがポップアップ表示され、「Confirm」

をクリックしてから、書き込むが開始します。 

 

After burning, DobotStudio will open automatically. Also, after about ten seconds, you can hear a 

short sound from built-in buzzer, which shows a successful burning. At the same time, the light on 

the bottom right will turn into green. We can then connect Dobot according to the above operation.  

書き込んだ後、DobotStudio が自動的に開きます。10 秒後、内臓ブザーから短音がなり、

書き込み完了と示しています。同時に、右下のランプが緑色になります。上記の操作に従

って Dobotに接続することができます。 
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7.3 Import Pattern and Set Parameters 画像の取り込みとパラメータの

設定 

1. The imported picture should be put into an area near the Dobot’s arm, as it will be at a limited 

position if beyond the standard writing range. If the Dobot is out of reach, then a red light will 

flash. 

You can also import pictures. Convert these formats (BMP/JPEG/JPG/PNG and so on) into 

SVG, which is recognized by Dobot. 

1．取り込まれた画像は、Dobotアームの近くに置く必要があります。標準的な動作範囲

を超えた場合、Dobotは制限された位置に止まります。アームが範囲を超えている場合、

警告する赤色ランプは点滅します。 

  画像を取り込むこともできます。ただし、これらの形式（BMP / JPEG / JPG / PNGな

ど）を SVG（Dobotが認識する形式）に変換する必要があります。 

 

Figure 7.4 Import engraving pictures 彫刻画像を導入する 

Open the picture, adjust the gray scale(0-255), laser power(0-100%) and the border for the 

customized engraving effect. 

画像を開いて、カスタマイズされる彫刻効果が出てくるようにグレースケール（0〜

255）、レーザー出力（0〜100％）を調整します。 
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Figure 7.5 Import the pictures into SVG file 画像を導入し、SVGファイルを生成する 

2. Set shade laser engraving velocity and acceleration, here we suggest 5, as shown below: 

2．次のように、シェードレーザー彫刻の速度と加速度を設定します（ここでは 5を推奨

する）。 

 
Figure 7.6 Set the parameter パラメータの設定 

7.4 Adjust Focus and Start to Engrave フォーカスを調整し、彫刻を開始

する 

1. Set the endeffector as Laser, as shown below:  

1．下図のように、エンドエフェクタをレーザーに選択します。 
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Figure 7.7 Set EndEffector エンドエフェクタを設定する 

 

2. Focus adjustment. Adjust the distance between the laser and engraving material and check ON 

to open the laser. 

2．フォーカスを調整します。レーザーと材料表面の間の距離を調整し、「ON」にチェッ

クを入れレーザーを起動します。 

 

Figure 7.8 Check the laser レーザーにチェックを入れる 

Focus Adjustment. Hold down the Unlock Key to adjust the distance between laser and the 

surface of the material, and then adjust the knob to focus it properly. It will be at the right height 



 

 

                                       
  

71 

 

Dobot Magician ユーザーマニュアル 

 

when the laser dot burns the brightest. Burn marks on the paper will be another indicator that you 

have done so correctly. One can cancel ticking to close laser after adjusting.  

フォーカスの調整：ロック解除キーを押しながら、レーザーと材料表面の間の距離を調整

し、ノブを適切にフォーカスするように調整します。レーザードットが最も明るくする場

合は、正しい高度を示しています。紙にバーマークがある場合、それが正しく行ったこと

を示す別の指標となります。調整後、レーザーをオフにするように、ボックスのチェック

を取り消すことができます。 

 

Figure 7.9 Focus adjustment 

図 7.9 フォーカスを調整する 

Notice： 

The laser can heat object when it is in focused state, objects like paper board or wood 

can be engraved or burned. 

! DO NOT focus the laser on people or animals 

! DO NOT let children play with it alone.   

! The process needs to be monitored when it is running 

! After the process, please turn off the laser promptly 

注意： 

レーザーはフォーカスが合った状態で物体を加熱することができるため、紙や木

などの物体を彫刻したり、燃やしたりすることができます。 

！人や動物にレーザーをフォーカスしないでください。 

！子供たちだけで遊んではいけません。 

！実行中のプロセスを監視する必要があります。 

 ！操作が終わったら、すぐにレーザーの電源を切ってください。 

 

3. Click AutoZ to set the current Z value, and then follow these steps:import 

pictures->Synchronous->Start) 

3．「AutoZ」をクリックし、現在の Z値を取得します。「import pictures」→「Synchronous」

→「Start」の順で操作してください。 
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Figure 7.10 Lock the height 高さをロックする 

Saved value of Z, check from here: 

ここには保存された Z値を確認することができます。 

 

Figure 7.11  Check the height 高度を確認する 

If the engraving isn’t clear, the laser height needs to be adjusted slightly. Revising the value of 

Pendown also helps. 

4. After focus adjustment, click SyncPos. The Dobot will move to the start position. 
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5. Click Start, Pause and Stop to control the Dobot. 

6. The result is shown below:  

彫刻が鮮明でない場合は、レーザーの高さをわずかに調整する必要があります。ペン下ろ

す値を再設定することも役立ちます。 

4．「SyncPos」をクリックすると、Dobotは自動的に開始点に移動します。 

5．「Start」、「Pause」、「Stop」ボタンで Dobotを制御できます。 

6．結果は以下のようになります。 

 

Figure 7.12 The Engraving Effect 彫刻結果 
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8. The Tutorial of 3D Printing 3D プリンティングのチュート

リアル 

The whole flow chart of 3D printing as shown below: 

3Dプリンティング全体の流れは以下となります。 

 

 

3D printing can use Repetier Host and Cura: 

3Dプリンティングでは Repetier Hostと Curaが使用できます。 

➢ Cura: Slicing is fast and stable, has strong inclusiveness to 3D model structure, less 

parameter settings, more users. 

➢ Repetier-Host: It can slice, check and modify G-Code, and control 3D printing manually. 

While it doesn’t offer built in slicing,it can use 3rd party slicing software, such as CuraEngine, 

Slic3r and so on. Finally, it has more parameter settings, making it very flexible.  

Here will introduce the details separately from the second step. 

Note: On Mac OS, Dobot can only use Cura,please refer to the tutorial of Cura. 

Cura：スライシングが速くて穏やかで、3D モデル構造に対して強い包括性を持ち、且つ

パラメータ設定がより少ないため、使っているユーザーが多いです。 

Repetier-Host: スライス、G コードのチェック、修正、および手動で 3Dプリンティング

の制御を行うことができます。内臓スライシングがありませんが、CuraEngine、Slic3rな

どのサードパーティーのスライシングソフトウェアが使用できます。最後に、より多くの

パラメータを持ち、非常に柔軟性があります。 

ここでは、第二ステップから個別に詳細を紹介します。 

注：Mac OSでは、Dobotは Curaのみが使用できるため、Curaのチュートリアルをご参

照ください。 

8.1 Installation of Accessories of 3D Printing 3Dプリンティングアクセ

サリーの取付 

3D printing accessories: extruder, hotend, motor cable and filament, as shown below: 

3Dプリンティングアクセサリーには、下図の通りに押出機、ホットエンド、モーターケ

ーブルおよびフィラメントが含まれます。 

Accessories 
Installation of 
3D Printing

Connect 
Repetier Host

Preparation 
before Printing

Import Models 
and Start to 

Print

3Dプリンティ
ングアクセサ
リーのインス

トール

Repetier Host
と接続する

印刷前の準備
モデル導入と
印刷開始
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Figure 8.1 Accessories of 3D Printing 3D プリンティングのアクセサリー 

The steps as follows: 

1. Press down the lever on the extruder by hand, and push down the filament to the bottom of the 

hole via the pulley. 

手順は以下となります。 

1．手で押出機のレバーを押し下げて、プーリを介してフィラメントを穴の底まで押し下

げます。プーリでフィラメントを穴の底まで押し込みます。 
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Figure 8.2 Insert filament  フィラメントを挿入する 

 

2. Insert the filament to PTFE Tube and push it down the bottom of the hotend, then tighten the 

Push-in fitting on the extruder. Notice: Make sure the PTFE Tube itself is pushed down to the 

hotend bottom. Otherwise, it will cause abnormal discharge.  

2．フィラメントを PTFE チューブに挿入し、ホットエンドの底部まで押し込み、押出機

のプッシュインフィッティングに締め付けます。注意：PTFE チューブ自体がホットエン

ドの底部までに押し込まれていることをご確認ください。底部までに押し込まられなかっ

た場合、異常放電をもたらします。 



 

 

                                       
  

77 

 

Dobot Magician ユーザーマニュアル 

 

 

Figure 8.3 Connect extruder and hotend 押出機とホットエンドを接続する 

3. Fasten hot end with butterfly nut;  

4. Connect power line of heating cable with interface 4 on the forearm, link power line of fan 

with interface 5, and connect thermistor line with interface 6. 

3．蝶ナットでホットエンドを締めます。 

4．加熱ケーブルの電源線をフォアアームのインターフェイス 4に、ファンの電源線をイ

ンターフェイス 5に、サーミスタ線をインターフェイス 6に接続してください。 

 

Figure 8.4 Connection of forearm フォアアームの結線図 

5. Connect extruder motor line with Stepper1 on the controller. 

5．コントローラーの Stepper 1と押出機モーターラインを接続してください。 
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Figure 8.5 Connection of extruder 押出機の結線図 

6. The whole kit should look like this: 

6．キット全体は以下のようになります。 

 

Figure 8.6 3D printing installation 3Dプリンティングの取付 

8.2 Repetier Host  Repetier Host 

8.2.1 Switch into 3D printing 3Dプリンティングに切り替える 

Repetier host has been built into DobotStudio. Open DobotStudio, click Tools-> Open 3D 

Printing： 

Repetier Hostは DobotStudio に組み込まれています。Dobotを起動し、「Tools」の「Open 

3D Printing」をクリックしてください。 
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A pop up a dialog of 3D printing burning firmware will appear. Click Confirm, and then Repetier 

Host will pop up automatically, as shown below: 

3D プリンティングのファームウェアを作成するダイアログがポップアップ表示されます。

「Confirm」をクリックすると、以下に示すように Repetier Hostが自動的にポップアップ

します。 

 

The interface of Repetier Host:  

Repetier Hostのインターフェイスは以下となります。 
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Figure 8.7 Repetier host 

図 8.7 Repetier host 

 

Note: If the current software is set for 3D printing, you can open DobotStudio directly when you 

want to use next time. Click Connect, select Ok, and then you can switch to Repetier Host, as 

follows:  

注：現在のソフトウェアが 3D プリンティング用に設定されている場合は、次回使用する

時に DobotStudioを直接的に開くことができます。「Connect」をクリックし、「OK」を

選択すると、次のように Repetier Hostに切り替えることができます。 
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Figure 8.8 Switch into 3D printing automatically 自動的に 3Dプリンティングに切り替える 

 

8.2.2 Parameter Settings of 3D printing for the first time 3Dプリンティングの

パラメータ初期設定 

Set this up when you use it for the first time ONLY. (You don’t need to do this twice!) 

Click ‘Printer settings’ in the top right corner of the interface, and set related parameters in the 

pop up diaglogue box: 

（1）Connection lable settings 

Printer Name: Dobot ( can be named by oneself) 

Select Dobot Serial Port: Dobot serial port 

Baud Rate: 115200 

Reset on connect:DTR low->high->low 

Reset on Emergency：Send emergency command+DTR high->low( If failed to connect, please try 

other options ) 

Receive cache size: 63 

The rest keep the default settings, click Apply after setting. 

最初に使用する場合のみ設定してください。（2回行う必要はありません。） 

インターフェイスの右上隅にある「Printer settings」をクリックし、関連パラメータをダ

イアログでポップアップ表示されて設定します。 

（1）接続ラベルの設定 

 プリンタ名：Dobot（自分で名前を付けることができます） 

 Dobotシリアルポート：Dobotシリアルポートを選択してください。 

 ボーレート：115200 

 接続時のリセット：DTR 低→高→低 

 緊急時のリセット：緊急コマンドの送信+ DTR高→低（接続に失敗した場合は、他の

オプションを試してください） 

 受信キャッシュサイズ：63 

 他はデフォルト設定のままで、設定後、「Apply」をクリックします。 
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Figure 8.9 Connection Settings 接続の設定 

（2）Connection Lable Settings 

（2）接続ラベルの設定 

uncheck the following three settings and keep the rest default: 

次の三つの設定のチェックを外し、ほかの設定はデフォルトにしてください。 
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Figure 8.10 Printer settings プリンタの設定  
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（3）Extruder Settings 

The number of extruder setting: 1 

 The nozzle diameter: 0.4mm 

 Keep the rest default. 

（3）押出機の設定 

 押出機の設定数：1 

 ノズル径：0.4mm 

 ほかはデフォルトにしてください。 

 

Figure 8.11 Extruder Settings 押出機の設定 

（4）Printer Shape Settings 

Select circle printer and the detailed parameters as follows: 

Home X： Min 

Home Y： Min 

Home Z： 0 

Print area radius:  80mm 

Print area height:  150mm 

Click Apply after setting. 

（4）プリンタの形状設定 

サークルプリンタと詳細なパラメータを次のように選択して下さい。 



 

 

                                       
  

85 

 

Dobot Magician ユーザーマニュアル 

 

ホーム X：最小  

ホーム Y：最小  

ホーム Z：0 

プリンティングエリアの半径：80ｍｍ 

プリンティングエリアの高さ：150ｍｍ 

設定後、「Apply」をクリックします。 

 

Figure 8.12 Printer Shape Settings プリンタの形状設定 

 

After setting parameters, return to the main interface. Open the Dobot main power supply, insert 

USB, and click Connect at the top left corner of main interface. Then, we can connect Dobot. The 

LED will turn green and the temperature will be shown below the interface: 

パラメータを設定したら、メインインターフェイスに戻ります。Dobotの主電源をつけて、

USB を挿入し、メインインターフェイスの左上隅にある「Connect」をクリックすると、

Dobotに接続できるようになります。LED が緑色に変わります。温度がインターフェース

の下に表示されます。 
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Figure 8.13 Connect Dobot 

図 8.13 Dobotと接続する 

 

8.2.3 Preparation before Printing プリンティング前の準備 

We need to melt the plastic to be able to have it flow properly, so we first heat the extrusion head. 

Here, set heating temperature to 200℃ and then click the heating button on the control 

panel to heat it. s 

Notice： 

The heating rod will produce high temperature up to 250℃, so please be careful！ 

DO NOT let children play with it alone.  

The process needs to be monitored when it is running.  

After the process, please turn off the equipment promptly.  

プラスチックが流れるようにプラスチックを溶かす必要があるので、最初に押出ヘッ

ドを加熱しておきます。ここでは、加熱温度を 200℃に設定し、コントロールパネル

の加熱ボタンをクリックして加熱します。 

注意： 

加熱ロッドは 250℃までの高温が生成されますので、ご注意ください。 

子供たちだけで遊んではいけません。 

実行中のプロセスを監視する必要があります。 
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  操作が終わったら、すぐに設備の電源を切ってください。

 

Figure 8.14 Heat the Extrusion Head 出ヘッドを加熱する 

 

When the heating temperature is up to 200℃, click the extruder feeder and feed up to 10-30mm, 

as shown below: 

加熱温度が 200℃の近くになる場合は、押出機フィーダーをクリックし、下図のように

10-30ｍｍまでフィードアップしてください。 
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Figure 8.15 Extrude filaments フィラメントを押し出す 

If melted materials flows from nozzle of the extruder, then it means the extruder is working 

properly: 

溶融材料が押出機のノズルから流れる場合は、押出機が適切に動いていることを示します。 

 

Figure 8.16 Filament Extrusion フィラメント押出 

Note: If the filament extrusion is in the opposite direction, simply remove the filament, turn the 

extruder around, and replace the filament.  

注：フィラメントが反対の方向から押出される場合、単にフィラメントを外し、押出機を

回してフィラメントを交換してください。 



 

 

                                       
  

89 

 

Dobot Magician ユーザーマニュアル 

 

 

Figure 8.17 Reverse installation diagram of the extruder 押出機の逆取付図 

8.2.4 Adjust the printing space and get printing coordinates 

プリンティングスペースを調整し、プリンティング座標を取得する 

During printing, if the distance between the nozzle and print is too large to paste the print bed of 

the first layer or if the distance is too small, which will cause a blockage, we need to adjust the 

proper distance for smooth printing. Generally, the thickness of a sheet of paper is OK so paste a 

layer of masking tape on the glass print bed in order to have the first layer printed adhere better. 

プリンティング中に、ノズルとプリントの間の距離が大きすぎて第一層のプリントベッド

を貼り付けることができない場合や、距離が小さすぎて詰まりが発生する場合は、スムー

ズにプリンティングするために適切な距離を調整する必要があります。最初層をよりよく

粘着するために、一般的に紙の厚さで OKですので、マスキングテープをガラスプリンテ

ィングベッドに貼り付けてください。 

 

Figure 8.18 Masking tape マスキングテープ 

 

Adjustment process: Press the Unlock key on the forearm and drag the printing head to contact the 

surface of the masking tape. Then, press “key” at the base of the Dobot to save the current Z value 

(or insert M415 in the command line, enter and get the current Z value).  
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Notice: 

After sending M415 or press “KEY”, Dobot will get current coordinates, if it is successful, you 

will hear a beep. Also, you don’t have to insert the command next time when printing. 

The window of command is shown below： 

調整プロセス：フォアアームのロック解除キーを押して、マスキングテープの表面に接触

させるためにプリンティングヘッドをドラッグしてください。次に、デボットの底にある

キーを押して、現在の Z値を保存します。（コマンドラインにM415を挿入し、現在の Z

値を入力して取得する） 

注意：「KEY」を押し、または M415を送信した後、デボットは現在の座標を取得し、成

功するとビープ音が鳴ります。 

 

 

Figure 8.19 Sending out M415 command  M415コマンドを送信する 

If you cannot find the command line window, please close Easy mode, as shown below: 

コマンドラインウィンドウが見つからない場合は、以下のように「Easy」モードを閉じてくだ

さい。 
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8.2.5 Import Model モデル導入 

The file format of 3D printing is STL, which is employed universally. 

Users can build one’s own 3D model and transfer it into a STL file, or search for free models to 

import them directly. Click open, import 3D model file (in STL format), as shown below: 

普遍的に採用されている 3Dプリンティングのファイルフォーマットは STLです。 
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ユーザーは独自の 3Dモデルを作成して STLファイルに変換するか、フリーモデルを検索

して直接導入することができます。「open」をクリックし、3D モデルファイル（STLフ

ォーマットで）が以下のように導入されています。 

 
Figure 8. 20 Import Models モデルを導入する 

Model Center/Scale: Users can operate the model to place in the middle, zoom or rotate and any 

other functions.  

モデルセンター/スケール：ユーザーはモデルを操作し、ミドル、ズーム、回転などの機

能を配置できます。 
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Figure 8.21 Model Center/Scale モデルセンター/スケール 

8.2.6 Set slice parameters and slice up スライスパラメータを設定してスライ

スする 

Select slice engine Slic3r and click Configuration to set slice parameters. 

スライスエンジン Slic3rを選択し、「Configuration」をクリックしスライスパラメータを

設定します。 
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Figure 8.23 Main interface of parameter settings パラメータ設定のメインインターフェイス 

Its important to set slice parameters, so users should get the best slice parameters according to 

printed models and tested performance of the equipment. Here we suggest a configuration file that 

can be impoted from attachement of DobotStudio:  
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スライスパラメータを設定することは重要です。そのため、ユーザーはプリンティングさ

れたモデルとテストされた装置の性能に従って、最適なスライスパラメータを取得する必

要があります。ここでは、DobotStudio の「attachement」から導入できる設定ファイルを

推奨します。 

 

图 8.24 Config files 設定ファイル 

 

Dobot-2.0-Vase.ini is used for printing a thin-valled vase, while Dobot-2.0.ini is used for filling, 

(the filling rate is 15%). 

Import the file after downloading: Click File->Load configto load.ini file. 

Dobot-2.0-Vase.iniは薄型花瓶のプリンティングに使用され、Dobot-2.0.iniは充填に使用さ

れます（充填率は 15％です）。ダウンロード後、ファイルを導入する：File→Load 

config.load.iniファイルをクリックします。 

http://www.dobot.cc/其中Dobot-2.0
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Figure 8.25 Import configuration file 配置ファイルの導入 

After importing the file, users need to save the three labels: Print settings, Filament settings and 
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Printer settings. Users can rename them, but the default names are recommended for clarity:  

ファイルを導入した後、ユーザーはプリンティング設定、フィラメント設定、プリンタ設

定の三つのラベルを保存する必要があります。ユーザーは名前を変更できますが、わかり

やすくするためにデフォルトの名前を使用することをお勧めします。 

 

Figure 8.26 Save configuration file 配置ファイルの保存 

 

Slice: After finishing above settings, save the settings of each label, and return to main interface. 

Select slic3r, import slice settings and click Slice with Slic3r.io 

スライス：上記の設定が終わったら、各ラベルの設定を保存し、メインインターフェイス

に戻ります。slic3r を選択し、スライス設定を導入し、Slic3r.io でスライスをクリックし

ます。 
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Figure 8.27 Finish slice スライスを仕上げる 

 

8.2.7 Start to Print プリンティング開始  

Now, click Start print at the top left corner of main interface to print： 

現在、メインインターフェイスの左上隅にある「Start print」をクリックしてプリンティ

ングします。 
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Here we choose vase mode, and the product after printing as follows:  

花瓶モードを選択して、プリンティング製品は次のようになります。 
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Figure 8.28 The Product of Printing プリンティング製品 
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8.3 Cura Introduction for 3D printing 3Dプリンティング用 Curaの紹

介 

If you want to use Cura for 3D printing, the details seen as follows: 

Notice: Installation of accessories and firmware burning shown as Repetier Host 3D printing.8.2 

Repetier Host 

3Dプリンティング用 Cura に関しては、次をご覧ください。 

注意：アクセサリーの取付とファームウェアの書き込みは 3Dプリンティング用 Repetier 

Hostをご参照ください。8.2 Repetier Host 

8.3.1 Cura parameter settings Curaパラメータの設定 

Cura is a free software that can be downloaded on its official website. We recommend you to use 

Version V14.07. You can download the software here: 

https://ultimaker.com/en/products/cura-software/list 

The software interface is as follows: 

Curaは公式サイトにダウンロードできる無料のソフトウェアです。バージョン V14.07を

使用することをお勧めします。下記のリンクからソフトウェアがダウンロードできます。 

https://ultimaker.com/en/products/cura-software/list 

ソフトウェアのインターフェイスは以下の通りです。 

 

Figure 8.29 Cura interface Cura のインターフェイス 

Machine->machine settings, set related parameters in the pop-up dialog: 

（1）Connection label settings 

maximum width：80mm  maximumdepth：80mm maximum height：150mm； 

Machine center 0,0：Need tick 

https://ultimaker.com/en/products/cura-software/list
https://ultimaker.com/en/products/cura-software/list
javascript:void(0);
javascript:void(0);
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Build Platform shape: Circular 

COM port setting: The corressponding COM port in the device management 

Baud rate：115200 

You can also choose to change the machine’s name. Keep the rest of the default settings and click 

OK after finishing. 

マシン→マシン設定、関連パラメータをポップアップ表示されるダイアログで設定します。 

（1）接続ラベルの設定 

 最大幅：80ｍｍ 最大深度：80ｍｍ 最大高度：150ｍｍ 

 マシンセンター0,0：チェックが必要 

 プラットフォームの形状を構築する：円形 

 COMポート設定：デバイス管理に対応する COMポート 

 ボーレート：115200 

 マシンの名前を変更することもできます。ほかのデフォルト設定はそのままにして、終

了後に「OK」をクリックします。 
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Figure 8.30 Machine settings マシン設定 

（2）Import configuration file 

It is vital to set slice parameters so users should get the best slice parameters according to printed 

models and tested performance of equipment. Here we suggest a configuration file that can be 

impoted from attachment of DobotStudio:  

（2）配置ファイルの導入 

スライスパラメータを設定することは重要です。そのため、ユーザーはプリンティングさ

れたモデルとテストされた装置の性能に従って、最適なスライスパラメータを取得する必

要があります。ここでは、DobotStudioの「attachement」から導入できる設定ファイルを

推奨します。 

 

 

Figure 8.31 Configure files 配置ファイル 
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Dobot-2.0-Vase.ini is used for printing a thin-valled vase, while Dobot-2.0.ini is used for the 

filling.(The filling rate is 15%.) 

Import the file after downloading: Click File->Load Profile. 

Dobot-2.0-Vase.iniは薄型花瓶のプリンティングに使用され、Dobot-2.0.iniは充填に使用さ

れます（充填率は 15％です）。 

ダウンロード後、ファイルを導入する：File-> Load Profile をクリックします。 

 

 

http://www.dobot.cc/其中Dobot-2.0
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Figure 8.32 Import configuration settings 配置設定の導入 

For more detailed printing parameters, go to the Cura website! 

（3）Open the model and connect Dobot 

Click Load, import a 3D model, and Cura will slice up automatically. You can also select different 

modes in the drop-down list located on the right to check if its trajectory is correct or not:： 

プリンティングパラメータの詳細については、Curaの Webサイトを参照してください。 

（3）モデルをオープンし、Dobotを接続する 

「Load」をクリックし、3D モデルを導入し、Curaは自動的にスライスアップします。ま

た、右側にあるドロップダウンリストで別のモードを選択して、その軌跡が正しいかどう

かをチェックすることもできます。 
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Figure 8.33 Import a model モデルを導入する 

 

Click the model to operate it. You can place it in the middle, zoom or rotate, as well as other 

functions. 
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モデルをクリックして操作します。ミドル、ズームや回転、および他の機能を配置するこ

とができます。 

 

After importing a model, Print with USB on the main interface will be activated. Click it to 

connect toDobot automatically. The screen will show the current printing temperature on the top 

corner of the window. At the same time, the Printing key will be activated, as shown below:  

モデルを導入した後、メインインターフェイスで「Print with USB」が有効になります。

それをクリックすると、自動的に Dobotに接続します。画面には、ウィンドウの上隅に現

在のプリンティング温度が表示されます。同時に、次のようにプリンティングキーが有効

になります。 
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Figure 8.34 Connect Dobot Dobotに接続する 

8.3.2 Preparation before Printing プリンティング前の準備 

Before printing, test the function of the extruder.Test to see if the filament flows in and out and if 

the direction of the filament is in reverse. Set the heating temperature to 200℃ and then press 

enter to heat the nozzle.  

Notice： 

The heating rod will produce high temperatures up to 250℃, please be careful！ 

DO NOT let children play with it alone.  

The process needs to be monitored when it is running.  

After the process, please turn off the equipment promptly. 

プリンティング前、押出機の機能をテストします。フィラメントの流入と流出、フィラメ

ントの方向が逆であろうかチェックします。加熱温度を 200℃に設定し、「enter」を押し

てノズルを加熱します。 

注意： 

加熱ロッドは 250℃までの高温が生成されますので、ご注意ください。 

子供たちだけで遊んではいけません。 

  実行中のプロセスを監視する必要があります。 

  操作が終わったら、すぐに設備の電源を切ってください。 
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In the heating process, the fan will turn on automatically. When the heating temperature is up to 

200℃, click the feedstock extruder and feed up to 10-30mm, as shown below:  

加熱処理では、ファンが自動的にオンになります。加熱温度が 200℃の近くになる場合は、

押出機フィーダーをクリックし、下図のように 10-30ｍｍまでフィードアップしてくださ

い。 
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If melted filament flows from the nozzle of the extruder, then it means the extruder is working 

properly: 

溶融材料が押出機のノズルから流れる場合は、押出機が適切に動いていることを示します。 

 

Figure 8.35 Filament Extrusion フィラメント押出 

Note: If the filament extrusion is in the opposite direction, simply remove the filament, turn the 

extruder around, and replace the filament.  

注：フィラメントが反対の方向から押出す場合、単にフィラメントを外し、押出機を回し

てフィラメントを交換してください。 

 

Figure 8.36 Reverse installation diagram of the extruder  押出機の逆取付図 

8.3.3 Adjust the printing space and get printing coordinates プリンティングスペースを調整

し、プリンティング座標を取得する 

Note: For more detailed steps, please refer to the above chapter Repetier Host.  

注：詳細な手順については、上記の Repetier Hostの章をご参照ください。 
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Figure 8.37 Distance adjustment 距離調整 

8.3.4 Start printing プリンティング開始 

Just click Print, and then start printing. 

「Print」をクリックすることだけでプリンティングが開始します。 
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Figure 8.38  Start printing プリンティング開始 

 

Note: During the printing, if the distance between the nozzle and print is too large or too small to 

paste the print bed of the first layer, there may be a blockage. We need to adjust the proper 

distance for smooth printing. If it is not proper height when printing the first layer, we can change 

the parameters in the initial-layer thickness. (For example, -0.1mm or +0.1mm.) After fixing it, 

Cura will slice the model automatically.Then you can test the print again. After testing, the default 

heught of first layer is 0.87mm. 

注：プリンティング中に、ノズルとプリントの間の距離が大きすぎるまたは小さすぎるこ

とで、第一層のプリントベッドを貼り付けることができない場合は、閉塞の恐れがありま

す。スムーズにプリンティングするために適切な距離を調整する必要があります。第一層

をプリンティングするときに適切な高度でない場合、「initial-layer thickness」でパラメー

タを変更することができます。（例えば、-0.1ｍｍまたは+0.1ｍｍ）それを修正した後、

Cura は自動的にモデルをスライスします。プリンティングを再度テストした後、第一層

のデフォルトの高さは 0.87mmです。 
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Figure 8.39 Amend the height of first layer 第一層の高さを修正する 

 

Here we choose vase mode, and the product after printing as follows:  

花瓶モードを選択し、プリンティング製品は次のようになります。 

 

Figure 8.40 The Product of Printing プリンティング製品 

 

8.3.5 Text note テキストノート 

Parameters Introduction of 3D printing 

Here we only introduce necessary parameter settings, and one can review the related links about 

the rest parameters: http://manual.slic3r.org/ 

http://manual.slic3r.org/
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（1） Printer settings 

Set the height of print layer: 0.2mm； 

The height of first layer: 0.35mm； 

3Dプリンティングパラメータの紹介 

ここでは、必要なパラメータ設定だけを紹介し、他のパラメータについて関連リンクで

確認できます。http://manual.slic3r.org/ 

（1）プリンタ設定 

 プリンティング層の高さを設定する：0.2ｍｍ 

 第一層の高さ：0.35ｍｍ 

 

Spiral vase: Check this one and click Yes. Then we can print unfilled vase. 

スパイラル花瓶：これをチェックして「Yes」をクリックします。未塗装の花瓶をプリン

ティングすることができます。 

http://manual.slic3r.org/
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The fill rate settings: 

充填率の設定 
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If users need print support, please tick Generate support material: 

ユーザーがプリンティングサポートが必要な場合は、「支持材」をチェックしてください。 

 

The speed settings: 

速度の設定 



 

 

                                       
  

117 

 

Dobot Magician ユーザーマニュアル 

 

 

 

（2） Filament settings 

Consumable diameter: 1.75mm 

       The temperature: 200℃ 

（2）フィラメントの設定 

  消耗品の直径：1.75ｍｍ 

  温度：200℃ 
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Open the fan: 

ファンをオープンする 
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（3） Printer settings  

The number of Extruder: 1 

The nozzle Z offset of extruder: 0mm 

Notice: If the height of nozzle is so large that consumables cannot paste onto the print bed 

or so small that it cannot discharge when printing the first layer, users can amend the 

height from this interface, such as -0.01mm or +0.01mm, thus, one need not adjust the 

height again.  

（3）プリンタの設定 

   押出機の数：1 

   押出機のノズル Zオフセット：0ｍｍ 

   注意：ノズルの高さは、大きすぎでプリンティングベッド上に消耗品を貼り付ける

ことができなくなったり、小さすぎで第一層をプリンティングするときに放電することが

できなくなる場合、ユーザーがこのインターフェイスから高さを修正することができます。

（例えば、-0.1ｍｍまたは+0.01ｍｍ）そのため、再度高さを調整する必要はありません。 
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G-code Settings: 

Start G-code: M106 

End G-code:  

M104 S0 ; turn off extruder 

G91      ;relative positioning 

G1 E-1 F300   ;retract the filament a bit before lifting the nozzle 

to release some of the pressure 

G1 Z+3 E-5 F{travel_speed}    ;move Z up a bit and retract filament even more 

G1 Y+50 

G90   

M107 

G-コードの設定 

スタート G-コード：M106 

エンド G-コード： 

M104S0:押出機を切ります。 

G91：相対的な位置 

G1E-1F300：圧力を解放するために、ノズルを持ち上げる前に、フィラメントを少し引っ

込めます。 

G1Z+3E-5F{travel_speed}：Ｚを少し動かしてフィラメントをさらに収縮させます。 

G1Y+50 

G90 
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M107 

 

 

The nozzle diameter settings: 0.4mm； 

The pump back speed settings: length=6 mm，speed=60 mm/s. 

ノズル径の設定：0.4mm 
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ポンプバック速度の設定：長さ＝6ｍｍ、速度＝60ｍｍ/ｓ
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9. Base Calibration and Sensor Calibration 

ベースキャリブレーション及びセンサーキャリブレーション 

9.1 Base Calibration ベースキャリブレーション 

Dobot Magician has been carefully calibrated before being shipped out. If the home position isn't 

in the middle when you use the Dobot(errors between 1°-2°is in the allowable range), it needs 

to be re-calibrated.  

出荷前に、Dobot Magician は慎重に調整されています。Dobotをご利用いただく際、ホー

ムポジションが中央にない場合（1°-2°の誤差は許容範囲内）、再調整する必要があり

ます。 

1. Put Dobot in the marked place, as shown below. 

1. 以下のように、印のある場所に Dobotを置きます。 

 

1. Figure 9.1 Put dobot in the marked place 印のある場所に Dobot を置きます 

2. Open Dobot Studio, click Tools, and choose Base Calibration, as shown below: 

2. Dobot Studio を開いて、Toolsをクリックし、以下のように、Base Calibration を選択

します。 
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Figure 9.2 Base Calibration ベースキャリブレーション 

3. Click Next, and Dobot will begin auto-homing. You can do the next step when the button 

changes from grey to white. 

3. Nextをクリックし、Dobotは自動ホーミングを開始します。ボタンがグレーから白に

変わると次の段階を実行できます。 

4. You need to fine tune the home position through +J1 and -J1 before clicking Calibration. 

put the nib in the line between A3 and B3, as shown below. 

4. Calibration をクリックする前に、+J1 及び-J1 でホームポジションを微調整する必要

があります。 
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Figure 9.3 Base Calibration ベースキャリブレーション 

5. Click Calibration, the Base Calibration will be finished. 

5. Calibrationをクリックし、ベースキャリブレーションが完了します。 
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9.2 Sensor Calibration センサーキャリブレーション 

If you find the pen faces upward paper during writing & drawing or 3D printing, the sensor needs 

to be calibrated. (The Dobot Magician has been carefully calibrated before shipping out. You don’t 

need to re-calibrate it before using it.) 

ライティング＆ドローイングや 3D プリンティング中にペンが上向きになる場合、センサ

を調整する必要があります。（Dobot Magician は出荷前に慎重に調整されています。利用

する前に、再調整する必要はありません。） 

1. Put Dobot on the marked place, shown as below. 

1. 以下のように、印のある場所に Dobotを置きます。 
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Figure 9.4 Put dobot in the marked place 印のある場所に Dobot を置きます 

2. Open Dobot Studio, click Tools, and choose Sensor Calibration, shown as below. 

Notice: Don’t calibrate the sensor until all end effectors are removed! 

2. Dobot Studio を開いて、Toolsをクリックし、以下のように、Sensor Calibration を選

択します。 

  注意：すべてのエンドエフェクタが取り外されるまでセンサーを調整しないでくださ

い。 
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Figure 9.5 Sensor Calibration センサーキャリブレーション 

3. Click Next, and the Dobot arm will carry out a preset action to compensate for the 

sensor coefficient of the front arm and rear arm. 

3. Nextをクリックし、Dobotアームは、フォアアームとリアアームのセンサー係数を補

償するためのプリセット動作を実行します。 

 

Figure 9.6 Sensor Calibration センサーキャリブレーション 

4. Click Next when the operation interface appears the instructions, shown as below. 

4. 以下のように、操作インターフェースが指示を表示すると、Nextをクリックします。 
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Figure 9.7 Sensor Calibration センサーキャリブレーション 

5. Continue to click Next. 

5. 続いて Nextをクリックします。 

  

Figure 9.8 Sensor Calibration センサーキャリブレーション 

6. Follow the instructions to calibrate sensor they appear and then click Next. 

6. 指示に従って、表示されたセンサーを調整し、Nextをクリックします。 
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Figure 9.9 Sensor Calibration センサーキャリブレーション 

After fine tuning, the nib should be in the center of A3, as shown below. 

微調整後、以下のように、ペン先は A3の中心にあるはずです 。 

 

Figure 9.10 Sensor Calibration Board0 センサーキャリブレーションボード 

7. Follow the instructions below, then click Next. 

7. 以下の指示に従って、Nextをクリックします。 

 

Figure 9.11 Sensor Calibrationセンサーキャリブレーション 

Do not touch the Dobot. Use the motion button and move Dobot to 2nd calibration position 

and fine tune it. Click Next when the nib is in the center of B3. Shown as below: 

Dobotに触れないでください。モーションボタンで Dobotを 2番目のキャリブレーシ

ョン位置に移動し、微調整します。ペン先が B3の中心にあるとき、Nextをクリック

します： 
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Figure 9.12 Sensor Calibration センサーキャリブレーション 

8. The distance between A3 and B3 is 80mm, so you don’t need to change the distance. 

Continue to click Next. 

8. A3 と B3 の距離は 80mm ですので、距離を変更する必要はありません。Next をクリ

ックします。 

 

9. Click Ok to finish sensor calibration. 

9. Okをクリックして、センサーキャリブレーションを終了します。 
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10. Bluetooth Kit Bluetooth キット 

10.1 Bluetooth module is included in this kit, and the installation shown as follows: 

10.1 Bluetoothモジュールはこのキットに含まれており、取付は次のように表示されます。 

 

Figure 10.1  Bluetooth module installation  Bluetooth モジュールの取付 

10.2 Switch off the Dobot and plug the Bluetooth module into the communication interface. After 

installation, power on the Dobot and you will hear three short beep sounds. This means the 

Bluetooth module has been installed. At this time, a blue light is on and a green light is flashing. 

10.2 Dobotの電源を切り、Bluetooth モジュールを通信インタフェースに接続します。イン

ストール後、Dobotの電源を入れると、短いビープ音が 3回鳴ります。これは、Bluetooth

モジュールがインストールされたことを意味します。現時点では、青色のランプが点灯し、

緑色のランプが点滅します。 

10.3 Turn on bluetooth on your phone (IOS), and then open the Dobot App to connect the Dobot 

arm . 

10.3ご利用の携帯（IOS）で bluetoothをオンにし、Dobotアプリケーションを開いて、Dobot

アームに接続します。 

You can refer to the detailed tutorial on Youtube: 

詳細は Youtubeをご参照ください： 

https://www.youtube.com/watch?v=kyeXwuf17IY 

 

Notice: Please make sure Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, 

Color sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status 

indicator light is off is when the Dobot is powered down. 

注意：Bluetooth モジュール、WIFIモジュール、USB ホストモジュール、赤外線センサー、

カラーセンサーなどの外部モジュールを接続/切断する前に、Dobotの電源が完全に切られ

https://www.youtube.com/watch?v=kyeXwuf17IY
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ていることを確認してください。それ以外の場合は、Dobotに損害を与える危険がありま

す。ステータスインジケータランプが消灯してから、Dobotの電源がオフになるので、ご

注意ください。 
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11. WIFI Kit WIFI キット 

The WIFI kit contains a WiFi module. Connect it into Dobot extensible port and use the USB 

cable to connect the Dobot together with your PC, as shown below:  

WIFIキットにはWiFiモジュールが含まれています。以下のように、それを Dobot拡張ポ

ートに接続し、USBケーブルで Dobotを PC と接続します。 

 

Figure 11.1  WiFi module WiFi モジュール 

Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, 

Color sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status 

indicator light is off is when the Dobot is powered down. 

注意：Bluetooth モジュール、WIFIモジュール、USB ホストモジュール、赤外線センサー、

カラーセンサーなどの外部モジュールを接続/切断する前に、Dobotの電源が完全に切られ

ていることを確認してください。それ以外の場合は、Dobotに損害を与える危険がありま

す。ステータスインジケータランプが消灯してから、Dobotの電源がオフになるので、ご

注意ください。 

 

11.1 Set Dobot WiFi module DobotWiFi モジュールを設置する 

When first using the WiFi module, you need connect the USB to configure the WiFi module. This 

is to create a virtual serial port. After setting it up, you can use the WiFi module alone without the 

USB cable. 

最初にWiFiモジュールを使用する際は、WiFiモジュールを設定するため、USBを接続す

る必要があります。これは、仮想シリアルポートを作成するためです。設定後、USBケ

ーブルを使わずにWiFiモジュールのみを使用することができます。 

1. Open DobotStudio, Click Connect->Tools->Wi-Fi, and enter into the parameter setting 
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interface. 

1. DobotStudioを開いて、Connect->Tools->Wi-Fiをクリックし、パラメータ設定インター

フェースに入ってください。 

 

2. Input related parameters of WLAN. 

2. WLAN の関連パラメータを入力します。 

 

Figure 11.2  Wi-Fi interface Wi-Fiインターフェース 

 Fill in Wifi name at “SSID” input box; 

 Fill in Wifi password at “Password” input box; 

 If you want to use function of DHCP, please tick checkbox; 

 Otherwise, fill in“IPAddress”、“Netmask”、“Gateway”、“DNS” and any other 

parameters. 

 「SSID」入力ボックスにWifi名を入力します。 

 「Password」入力ボックスに Wifiのパスワードを入力します。 
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 DHCP の機能を使用する場合は、チェックボックスをオンにしてください。 

 それ以外の場合は、 「IPAddress」「Netmask」「Gateway」「DNS」などのパラ

メータを入力します。 

Generally, use DHCP. Click OK to finish setting up. Wait several seconds, and the green indicator 

of the Dobot WiFi wireless module will be on, which means that the Dobot has been connected 

with WLAN.  

通常、DHCP を使用します。OK をクリックして、セットアップを完了します。数秒後、

Dobot WiFi無線モジュールの緑色のインジケータが点灯します。これは、DobotがWLAN

に接続されたことを意味します。 

 

Figure 11.3 Connected with WLAN WLAN で接続 

Then you will find out the IP address, located on the main interface of DobotStudio as shown 

below: 

次に、以下のように、DobotStudioのメインインターフェースにある IP アドレスを見つけ

ます： 

 

Figure 11.4 Dobot IP address DobotIP アドレス 
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Select the address, click Connect, then you can control the Dobot through WiFi. On future uses,  

just insert the WiFi module and connect the Dobot through the address. 

アドレスを選択し、Connectをクリックすると、WiFi で Dobotを制御できます。次回以降、

WiFiモジュールを挿入してアドレスに Dobotを接続するだけで Dobotを制御できます。 
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12. Stick controller kit スティックコントローラキット 

12.1 GameSir Joystick Instruction GameSir ジョイスティックの紹介 

1. The Stick controller kit includes a gamepad and USB Host module. Connect wireless module 

into the 10pin communication port behind the controller. There are two ways to connect, wired 

and wireless, shown as follows: 

1. Stickコントローラキットには、ゲームパッドと USB ホストモジュールが含まれていま

す。無線モジュールをコントローラーの後ろの 10ピン通信ポートに接続します。以下の

ように、有線と無線の 2つの接続方法があります。 

 

Figure 12.1 Installation of stick module スティックモジュールの取付 

2. For wireless mode: (Before starting, make sure to install the module first!) When syncing the 

gamepad, the green LED will light up and you will hear 4 short beeps. This means that the 

gamepad has finished initializing. At the same time, press the button Home and A to start up the 

gamepad.  

2.無線の場合：（起動する前に、まずモジュールをインストールしてください。）ゲーム

パッドを同期させると、緑色の LED が点灯し、短いビープ音が 4回鳴ります。これは、

ゲームパッドの初期化が完了したことを意味します。同時に、ホームボタンと Aボタン

を押して、ゲームパッドを起動します。 

 

Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, 

Color sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status 

indicator light is off is when the Dobot is powered down. 

注意：Bluetooth モジュール、WIFIモジュール、USB ホストモジュール、赤外線センサー、

カラーセンサーなどの外部モジュールを接続/切断する前に、Dobotの電源が完全に切られ

ていることを確認してください。それ以外の場合は、Dobotに損害を与える危険がありま

す。ステータスインジケータランプが消灯してから、Dobotの電源がオフになるので、ご

注意ください。 
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Figure 12.2 Start up the stick スティックを起動します 

Now, the front button LED will turn on, and the LED beneath will flash: 

これでフロントボタンの LED が点灯し、下の LEDが点滅します： 

 

Figure 12.3 Stick at work 作動中のスティック 

3. There are two way to use the gamepad, Linear mode and Jog mode, which can be switched by 

button L1/R1(L1 refers to jog mode and R1 refers to linear mode).The control mode details are 

shown below: 

3.ゲームパッドを使用するには、リニアモードとジョグモードの 2つの方法があり、L1 / 

R1ボタンで切り替えることができます（L1はジョグモードで、R1はリニアモードです）。 

（1） Linear mode 

（1）リニアモード 

Function 

機能 

Corressponding buttons 

対応ボタン 

Start up stick 

スティックを起動 

Hold down Home and A for 2 seconds 

Home と Aを 2秒間押し続けます 

Close the stick Hold down Home for 2 seconds 
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スティックを閉じます Homeを 2秒間押し続けます 

Dobot X+/X- 

Dobot X+/X- 

Pad.LeftStick. front/back 

パッドの左スティック 表/裏 

Dobot Y+/Y- 

Dobot Y+/Y- 

Pad.LeftStick. left/right 

パッドの左スティック 表/裏 

Dobot Z+/Z- 

Dobot Z+/Z- 

Pad.LeftStick. front/back 

パッドの左スティック 表/裏 

Joint4 servo rotation R+/R- 

ジョイント 4 サーボ回転 R + / R- 

Pad.LeftStick. left/right 

パッドの左スティック 表/裏 

Suction cup ON 

サクションカップ ON 

Y key 

Y キー 

Gripper ON 

グリッパーON 

X key 

Xキー 

Release suction cup/gripper 

サクションカップ・グリッパーを解

放 

B key 

B キー 

Chart 12.1 Linear mode 

図表 12.1 リニアモード 

（2）Jog Mode 

（2）ジョグモード 

Function 

機能 

Corressponding buttons 

対応ボタン 

Start up stick 

スティックを起動 

Hold down Home and A for 3 seconds 

Home と Aを 3秒間押し続けます 

Close the stick 

スティックを閉じます 

Hold down Home for 3 seconds 

Homeを 3秒間押し続けます 

Dobot Joint1+/ Joint1- 

Dobot Joint1+/ Joint1- 

Pad.LeftStick. front/back 

パッドの左スティック 表/裏 

Dobot Joint2+/ Joint2- 

Dobot Joint2+/ Joint2- 

Pad.LeftStick. left/right 

パッドの左スティック 表/裏 

Dobot Joint3+/ Joint3- 

Dobot Joint3+/ Joint3- 

Pad.LeftStick. front/back 

パッドの左スティック 表/裏 

Joint4 servo rotation R+/R- 

ジョイント 4 サーボ回転 R + / R- 

Pad.LeftStick. left/right 

パッドの左スティック 表/裏 

Suction cup ON 

サクションカップ ON 

Y key 

Y キー 

Gripper ON 

グリッパーON 

X key 

Xキー 

Release suction cup/gripper 

サクションカップ・グリッパーを解

放 

B key 

B キー 

Chart 12.2 Jog mode 

図表 12.2 ジョグモード 
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12.2 Beitong Joystick Instruction 北通ジョイスティックの紹介 

The Beitong joystick kit includes a joystick, USB Host, charger, and a wireless receptor. 

北通ジョイスティックキットには、ジョイスティック、USBホスト、充電器、及びワイ

ヤレスレセプタが含まれています。 

 

Figure 12.4 Joystick Module ジョイスティックモジュール 

1. Before plugging in the charger into the Dobot Magician, Connect the USB Host with the Dobot 

Magician via the 10pin communication interface on the back of the unit.  

1.充電器を Dobot Magician に差し込む前に、ユニットの背面にある 10ピンの通信インタ

ーフェイスを介して、Dobot Magicianと USBホストを接続します。 

 

Figure 12.5 Installation of Beitong Joystick 北通ジョイスティックの取付 
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2. Plug the charger and turn on the Dobot Magician. When the installation is finished, the green 

light on the USB Host will turn on and four short sounds will be heard, which means the 

initialization is completed. Press the Logo button on the joystick and it will start. 

2.充電器を接続し、Dobot Magician をオンにします。インストールが終了すると、USBホ

ストの緑色のランプが点灯し、短い音が 4つ鳴ります。これは、初期化が完了したことを

意味します。ジョイスティックのロゴボタンを押すと起動します。 

Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, 

Color sensor, etc. Otherwise, you risk damaging the Dobot! Remember that only until the status 

indicator light is off is when the Dobot is powered down. 

注意：Bluetooth モジュール、WIFIモジュール、USB ホストモジュール、赤外線センサー、

カラーセンサーなどの外部モジュールを接続/切断する前に、Dobotの電源が完全に切られ

ていることを確認してください。それ以外の場合は、Dobotに損害を与える危険がありま

す。ステータスインジケータランプが消灯してから、Dobotの電源がオフになるので、ご

注意ください。 

 

Figure 12.6 Start Joystick ジョイスティックの起動 

The red light between the left bar and the right bar will flicker. 

左スティックと右スティックの間の赤いランプが点滅します。 
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Figure 12.7 The operating Joystick ジョイスティックの操作 

3. You can control the Dobot arm through the joystick. There are two control modes: Linear 

Mode and Jog Mode (LB refers to jog mode and RB refers to linear mode). They can be easily 

switched through the corresponding keys on the Joystick. 

The instructions are shown below: 

3.ジョイスティックで Dobotアームを制御できます。リニアモードとジョグモードの 2つ

のコントロールモードがあります（LBはジョグモードで、RBはリニアモードです）。

ジョイスティックの対応するキーを使って簡単に切り替えることができます。 

指示は以下のように： 

(1)Linear Mode 

(1)リニアモード 

Function 

機能 

Corresponding buttons 

対応ボタン 

Start Joystick 

ジョイスティックを起動 

Press the Logo Key for 3 Seconds 

ロゴキーを 3秒間押し続けます 

Turnoff Joystick 

ジョイスティックをオフにします 

Auto Turnoff 

自動オフ 

Robotic Arm X+/Y- Axis 

ロボットアーム X + / Y軸 

Move Left Bar Forward/Backward 

左スティックを前・後ろに移動 

Robotic Arm Y+/Y- Axis Move Left Bar Right/ Left 
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ロボットアーム Y + / Y 軸 左スティックを右・左に移動 

Robotic Arm Z+/Z- Axis 

ロボットアーム Z + / Z軸 

Move Right Bar Forward/Backward 

右スティックを前・後ろに移動 

Joint4 Steering Gear Spinning R+/R- 

ジョイント4ステアリングギヤスピニ

ング R + / R- 

Move Right Bar Right/Left 

右スティックを右・左に移動 

Suction Cup ON 

サクションカップ ON 

Y key 

Y キー 

Gripper 

グリッパーON 

X key 

Xキー 

Release Suction Cup/Gripper 

サクションカップ・グリッパーを解放 

B key 

B キー 

Chart 12.3 Linear Mode リニアモード 

(2)Joy Mode 

(2)ジョグモード 

Function 

機能 

Corresponding buttons 

対応ボタン 

Start Joystick 

ジョイスティックを起動 

Press the Logo Key for 3 Seconds 

ロゴキーを 3秒間押し続けます 

Turnoff Joystick 

ジョイスティックをオフにします 

Auto Turnoff 

自動オフ 

Robotic Arm  Joint1+/Joint- 

ロボットアーム Joint1+/ Joint1- 

Move Left Bar Forward/Backward 

左スティックを前・後ろに移動 

Robotic Arm  Joint2+/ Joint2- 

ロボットアーム Joint2+/ Joint2- 

Move Left Bar Right/ Left 

左スティックを右・左に移動 

Robotic Arm  Joint3+/ Joint3- 

ロボットアーム Joint3+/ Joint3- 

Move Right Bar Forward/Backward 

右スティックを前・後ろに移動 

Joint4 Steering Gear Spinning  R+/R- Move Right Bar Right/Left 
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ジョイント4ステアリングギヤスピニ

ング R + / R- 

右スティックを右・左に移動 

Suction Cup ON 

サクションカップ ON 

Y key 

Y キー 

Gripper ON 

グリッパーON   

X key 

Xキー 

   Release Suction Cup/Gripper 

サクションカップ・グリッパーを解放 

B key 

B キー 

Chart 12.4 Jog Mode ジョグモード 

Note: If the Joystick cannot control the Dobot Magician after pressing the Logo key, hold the 

Logo key to reset connection. 

注意：ロゴキーを押した後にジョイスティックで Dobot Magicianを制御できない場合、ロ

ゴを押し続けて接続をリセットします。 
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13. Leap Motion Kit Leap Motion キット 

13.1 Connect the Leap Motion module to the PC through USB cable. 

 

13.1 Leap Motionモジュールを USB ケーブルで PCに接続します。 

 

Figure 13.1  Leap motion module  Leap Motion モジュール 

13.2 Download the Leap motion driver and install it. (Here is the link: 

https://www.leapmotion.com/setup)  

13.2 Leapモーションドライバをダウンロードしてインストールします。（URL：

https://www.leapmotion.com/setup） 

https://www.leapmotion.com/setup
https://www.leapmotion.com/setup
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Follow the directions below and keep installing until it’s done. 

以下の指示に従い、完了までインストールを続けます。  
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Figure 13.2 Successful installation インストール完了 

13.3 After installing, start up the equipment and open DobotStudio. Click Leap Motion to enter the 

interface: 

13.3インストール後、機器を起動して DobotStudioを開きます。 インターフェイスに入

るには、Leap Motionをクリックします。 
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Figure 13.3 Leap motion interface Leap Motion インタフェース 

13.4 Start: To keep the Dobot stable, turn your palm up to move into controlled area of Leap 

Motion. The Dobot will move accordingly. (Hold hands to trigger the suction cup or gripper.)  

13.4開始：Dobotを安定した状態に保つには、手のひらを上に向け、Leap Motion の管理

エリアに移動します。Dobotはそれに応じて移動します。（吸盤またはグリッパーを

作動させるために手で持ってください。） 

13.5 Turn palm up: remove hand from surveyed area of Leap Motion. 

13.5手のひらを上に向ける：Leap Motionの測量エリアから手を離します。 

13.6 Stop: Exit Leap Motion mode. 

13.6停止：Leap Motion モードを終了します。 

13.7 Settings: Set up speed and scale ratio;  

13.7設定：速度とスケール比を設定します。 
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Speed：Speed adjustment; 

速度：速度調整 

Scale：Coordinates ratio between leap motion and Dobot;  

比率：飛躍運動と Dobotとの比率を調整します。 

Low resource/high resource: Set as low-resource mode for low-performance computers. 

低リソース/高リソース：パフォーマンスの低いコンピュータで低リソースモードに

設定します。 
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14. Mouse control マウスコントロール 

14.1 The software used for mouse control is DobotStudio. Please open the software and enter into 

mouse module interface, as shown below: 

14.1マウスコントロールに使用されるソフトウェアは DobotStudioです。ソフトウェアを

開き、以下のようにマウスモジュールインターフェイスに入ってください： 

 

 

Figure 14.1 Enter into mouse controlling interface マウスコントロールインターフェースに入る 

14.2 V key: Start and Stop; 

14.2 Vキー：開始及び終了 

14.3 Settings: Set up related velocity and acc; 

14.3設定：関連する速度及び加速度の設定。 
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Figure 14.2 Parameter settings パラメータ設定 

Speed (percentage)：0-100, we suggest 50； 

速度（パーセンテージ）：0-100 50をおすすめ 

Scale (percentage): 0-100, we suggest 100; 

比率（パーセンテージ）：0-100 50をおすすめ 

We suggest users with a lower performance computer to opt for the low performance option. 

パフォーマンスの低いコンピュータをご利用のユーザーには、パフォーマンスの低いオプ

ションを選択することをおすすめします。 

 

Figure 14.3 Parameter settings パラメータ設定 

Scale X/Y/Z：Scale ratio between mouse coordinates and Dobot coordinates; 
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比率 X / Y / Z：マウス座標と Dobot座標との比率 

Sample：20-60, depending on PC performance; 

サンプル：20-60  PCのパフォーマンスによって異なります。 

DobotCenter: Keep default settings; 

DobotCenter：デフォルト設定を維持 
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15. Blockly Blockly 

Dobot Blockly is a programming platform based on Google Blockly. In this process, users can 

program through the puzzle format, which is straightforward and easy to understand. Also, users 

can use the integrated API of Dobot anytime.  

Dobot Blocklyは Google Blocklyに基づくプログラミングプラットフォームです。このプロ

セスでは、ユーザーは簡単で分かりやすいパズル形式でプログラムできます。また、ユー

ザーはいつでも Dobotの統合 APIを利用できます。 

15.1 Blockly Interface Blockly インタフェース 

1. Open DobotStudio and click DobotBlockly: 

1. DobotStudioを起動し、DobotBlockly をクリックします。 

 
Figure 15.1 Enter into DobotBlockly DobotBlockly画面に入ります 

2. 5 areas are included in this window: 

2. このウィンドウには 5つエリアが含まれています： 

 
Figure 15.2 DobotBlockly Interface DobotBlocklyインタフェース 

Area 1： 
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New/Open/Save：New/Open/Save the current files 

エリア 1： 

New/Open/Save：現在のファイルを新規作成/開き/保存します。 

Area 2： 

Start/Stop 

エリア 2： 

Start/Stop 

Area 3： 

This part includes the current point location info of Dobot. Log information is in the middle, while 

programming code is on the left:  

エリア 3： 

この部分には、Dobotの現時点での位置情報が含まれています。ログ情報は中間にあり、

プログラミングコードは左側にあります。 

 

Figure 15.3 Code information コード情報 

Area 4： 

This part has the selection area of blockly module, including logistic, loop, math, Dobot API and 

so on. Just drag them to the window that is OK. 

Dobot API has many functions, such as velocity/acc, end effector settings, move mode, linear or 

jog mode and each interface of I/O configuration. It is very convenient for secondary 

development.  

エリア 4： 

この部分には、ロジスティック、ループ、数値、Dobot APIなどのブロック単位の選択エ

リアがあります。ウィンドウにドラッグするだけで結構です。 

Dobot APIには、速度・加速度、エンドエフェクタ設定、移動モード、リニア・ジョグモ

ード、I/O 設定の各インタフェースなど、多くの機能があります。二次開発には非常に便

利です。 

Area 5： 

Main window of blockly programing 

エリア 5： 

ブロックプログラムのメインウィンドウ 

Area6:  

Home and emergency stop. 

エリア 6： 
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ホーム及び緊急停止。 

15.2 Blockly Demo Blockly デモ 

Here is one basic demo, shown as follows: 

下記は、基本的なデモです。 

 
Figure 15.4 Programing demo プログラミングデモ 

Explanation of Demo: Set endeffector as gripper, set the loop number as 3, and make the Z axis 

move back and forth 3 times. After this, click Start, and the Dobot will move accordingly.  

デモについて：エンドエフェクタをグリッパに設定し、ループ番号を 3に設定し、Z軸を

前後に 3回移動させます。この後、Startをクリックすると、Dobotがそれに応じて移動

します。 
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16. Function Description of LinearRail LinearRail の機能について 

About connecting the rail with Dobot, you can refer to the installation instructions of LinearRail. 

Plug the wires into the base of Dobot after connecting LinearRail with the Dobot. As shown 

below: 

Dobotとレールの接続については、LinearRailのインストール手順を参照してください。

LinearRailと Dobotを接続した後、ワイヤーを Dobotのベースに差し込みます。以下のよ

うに： 

 

Figure 16.1 LinearRail connect to Dobot arm Dobotアームに接続する LinearRail  

Notice: Please make sure the Dobot is completely powered down before connecting/disconnecting 

extenal modules such as Bluetooth module, WIFI module, USB-Host module, Infrared sensor, 

Color sensor,etc. Otherwise, you risk damaging the Dobot! Remember that only until the status 

indicator light is off is when the Dobot is powered down. 

注意：Bluetooth モジュール、WIFIモジュール、USB ホストモジュール、赤外線センサー、

カラーセンサーなどの外部モジュールを接続/切断する前に、Dobotの電源が完全に切られ

ていることを確認してください。それ以外の場合は、Dobotに損害を与える危険がありま

す。ステータスインジケータランプが消灯してから、Dobotの電源がオフになるので、ご

注意ください。 
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Figure 16.2 LinearRail wiring diagram LinearRail 配線図 

How to write & draw through the LinearRail: You can use CorelDRAW X7 to transform content 

into PLT format. The software can be downloaded from internet. For more details about software 

operation, refer to the PLT format instructions document. 

LinearRailでのライティング＆ドローイング方法：CorelDRAW X7を使用してコンテンツ

を PLT形式に変換できます。ソフトウェアはインターネットからダウンロードできます。

ソフトウェア操作の詳細については、PLT形式の指示書を参照してください。ソフトウェ

ア操作の詳細については、PLT 形式の説明書を参照してください。 

 

1. Open DobotStudio, click LinearRail and the button at the right corner of Operation Panel, 

and choose Linear Rail control, as shown below: 
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1. 以下のように、DobotStudio を開き、LinearRailと操作パネルの右隅にあるボタンをク

リックし、Linear Rail controlを選択します。 

 

Figure 16.3 Click LinearRail 

画像 16.3 LinearRail をクリック 

2. After clicking LinearRail, you need to test whether the LinearRail can move properly. Click 

L+ or L-. The Dobot would move left or right. 

2. LinearRail をクリックした後、LinearRail が適切に動くかどうかをテストする必要が

あります。L+または L-をクリックします。Dobotは左または右に移動します。 
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Click Setting and choose Jog to change the velocity and acceleration of the LinearRail. 

Available distance of LinearRail: 0-1000 mm; 

Maximum load: 5kg. 

Settingをクリックし、Jogを選択し、LinearRailの速度と加速度を変更します。 

LinearRailの利用可能距離：0-1000 mm。 

最大荷重：5kg。 
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Figure 16.4 LinearRail motion test LinearRail モーションテスト 

3. The Dobot needs to reset. Press the Home button before you do anything else. 

Notice: Before you press the Home button, please take the pen off and/or raise the dobot arm 

up. 

3. Dobot をリセットする必要があります。他に何かする前に、Home ボタンを押してく

ださい。 

  注意：Home ボタンを押す前に、ペンを外してください。また、Dobot アームを持ち

上げてください。 

 

Figure 16.5 Home test ホームテスト 

4. Click Write&Draw after finish homing. 

4.  ホーミングプロセス終了後、「Write&Draw」をクリックします。 
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Figure 16.6 LinearRail operation panel 

画像 16.6 LinearRail 操作パネル 

5. Click Open to import the PLT files. 

5.  Open をクリックし、PLT ファイルをインポートします。 

 

Figure 16.7 Import file 

画像 16.7 ファイルをインポート 

6. Click options in the left side of Write&Draw to adjust position and size of characters. 

6.  Write&Drawの左側にある optionsをクリックし、文字の位置とサイズを調整します。 
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Figure 16.8 Operation Panel 操作パネル 

7. Adjust the height of pen, as shown below: 

7. 以下のように、ペンの高さを調整します： 

 

Figure 16.9 the height of pen ペンの高さ 

8. Click AutoZ to save the height of the pen (i.e. keep the position coordinate of Z-axis). 

8. AutoZをクリックし、ペンの高さを保存します（すなわち、Z軸の位置座標を維持）。 

http://www.baidu.com/link?url=fFhqH_Nu8wc6l1SUvCxx4yPY6dXMvuV6USIHigihhkQdRyt2z11e1lTbnozGIcTUXxV_2ud_lKXUWJ5HaMS_JjAnZ9LNXSeZ6BrcJ0aEDxG
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Figure 16.10 AutoZ  AutoZ 

9. Click SyncPosition and the Dobot will move to the initial position. 

9.  SyncPositionをクリックし、Dobotは最初の位置に移動します。 

Figure 16.11 SyncPosition 位置同期  

10. Click Start and the Dobot will write automatically. 

「Start」をクリックすると、Dobotが自動的にライディングを開始します。 

Note: If users want to set an action to dip the pen into the ink, please refer to the steps below. It 

uses the Teaching & Playback module. (Everytime you press Unlock Key and then release, the 

Dobot records a point’s position.) 

注意：ユーザがペンをインクに浸す動作を設定したい場合は、以下の手順を参照してくだ

さい。ティーチング＆プレイバックモジュールを使用します。（ロック解除キーを押して

から離すたびに、Dobotはポイントの位置を記録します。） 

（1） Set ink dipping position, as shown below, right click blank spaces, and add playback 

triggers. 
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A playback trigger causes one ink dipping motion. 

（1） 以下のように、インク浸漬位置を設定し、空白を右クリックし、プレイバックト

リガを追加します。 

   プレイバックトリガは、1回のインク浸漬動作を引き起こします。 

Figure 16.12 Set dip ink position ディップインクの位置設定 

（2） Return to Teaching & Playback module to set ink dipping actions. 

（2） ティーチング＆プレイバックモジュールに戻り、インク浸漬動作を設定します。 

Figure 16.13 Return to Teaching&Playback ティーチング＆プレイバックに戻る 

（3） Press the Unlock Key in forearm, move the forearm to the right place, and release the 

Unlock Key to record the first point position. This point position need to be a little high, 

but do not over the limit position. It will prevent the writing brush from touching the 

inkstone. 

（3） フォアアームのロック解除キーを押し、フォアアームを正しい場所に移動させ、

ロック解除キーを放して最初のポイント位置を記録します。このポイント位置は少し高く
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する必要がありますが、限界位置を超えないようにしてください。ペンが硯に触れるのを

防ぎます。 

 

Follow the following steps for save points. Move the forearm to the related position, and 

use Teaching & Playback to record these points, as shown below: 

セーブポイントについては、以下の手順に従ってください。 フォアアームを関連

する位置に動かし、以下のようにこれらの点を記録するためにティーチング＆プ

レイバックを利用します： 

 

Figure 16.14 Simulate the actions of ink dipping インク浸漬動作をシミュレート 

 

These are the actions to shake off loose ink between the right and left sides. 

これらは、左右間のインクを振り払う動作です。 

 

Figure 16.15 Simulate the actions of ink dipping インク浸漬の動作をシミュレート 

Raise the writing brush up to prevent it from touching the inkstone. 
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硯に触れないようにペンを上げてください。 

 

Finish recording the ink dipping actions and return to the Write & Draw module to start 

writing in LinearRail. 

インクディッピング動作の記録を終了し、ライティング＆ドローイングモジュー

ルに戻り、LinearRailで書き込みを開始します。 

 

Notice: The inkstone has its own height, so you need to set a suitable rising height to prevent the 

writing brush from touching the inkstone. (We recommend doing PenUpOffset between 50 to 75.) 

注意：硯は独自の高さを有するので、ペンが硯に触れないように、適切な高さを設定する

必要があります。（ペン持ち上げ高さを 50-75に設定することをおすすめします）。 
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17. More support その他サポート 

➢ For more information,visit http://cn.dobot.cc/ 

➢ 詳細については、http://cn.dobot.cc/をご覧ください。 

 

➢ For more detailed material about software, second development and any others,visit 

http://cn.dobot.cc/download-center/dobot-magician.html 

➢ ソフトウェアの詳細については、http://cn.dobot.cc/download-center/dobot-magician.htmlをご覧

ください。 

 

➢ Share your idea on Dobot forum http://forum.dobot.cc/ 

➢ Dobot掲示板 http://forum.dobot.cc/で意見を共有します。 

 

➢ Further question, welcome to send email at support@dobot.cc 

➢ お問い合わせは、support@dobot.ccまでメールにてお願い申し上げます。 

http://cn.dobot.cc/
http://cn.dobot.cc/
http://cn.dobot.cc/download-center/dobot-magician.html
http://cn.dobot.cc/download-center/dobot-magician.html
http://forum.dobot.cc/
http://forum.dobot.cc/
mailto:support@dobot.cc
mailto:support@dobot.cc
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